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CHAPTER 1

Introduction

Objectives
1. Overview of the software.
2. Overview of the database.
3. How to start XMIM.

This manual is intended as an introduction to the XMIM research product. Each lesson contained within this
manual is intended to familiarize you with the software and to demonstrate how the software may be used to
perform meaningful market-driven research. For more information on the XMIM product, see the XMIM
User Guide.

The format of each lesson is broken down into:

● a brief discussion about the market applicability of the specific program’s functionality to be learned within
the lesson;

● an explanation of the problem to be solved within the lesson, step-by-step instruction on how to use the
program to solve the problem;

● an overview of the program’s functions used within the lesson; and

● a set of ‘problem solvers’ which allow you to try out your new XMIM research skills.

http://www.lim.com/pdfdocs/xmimuser6x.pdf
http://www.lim.com/pdfdocs/xmimuser6x.pdf
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Overview of the Software
Logical Information Machines, Inc. (LIM) has a suite of research software products that allows a researcher
to comprehensively analyze and forecast the markets. The software has an automatic link to an extensive
database. This two-part package of the software and database will allow you to:

● create historical pricing graphs (example: a 52-week daily price graph of your security with bollinger bands);

● create event-driven analysis (example: seasonality studies); and

● back-test trading strategies (example: a historical profit and loss report generated from entry/exit
conditions triggered by a moving average trading system).
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Contents of LIM’s Software Suite
LIM's suite of research software includes the following:

● XMIM, A menu-driven interface designed to model and evaluate trade opportunities. The software uses a
near-English query language to build queries (questions) about historical data.

● MIMIC, a software package that provides a point-and-click interface to access data on the MIM server.
Use MIMIC to create comprehensive price graphs and charts, including technical analysis overlays and
seasonality studies. Build formulas and easily do units of measure and currency conversions.

● MIM Excel Add-in, allows for easy data retrieval within an Excel spreadsheet.

● Application Programming Interfaces (APIs), that include Java, .Net, C++, C# and BMIM. These APIs
create an open architecture which allows writing of custom applications to serve your special needs, as well
accessing LIM data with third-party products.
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Overview of the Database
LIM time series data offerings include energy, equities, futures, fixed income, foreign exchange, economic
indicators, weather data, daily price data for all domestic stocks traded at the NYSE, AMEX, and NASDAQ
and OTC, daily data for U.S. and international futures contracts, U.S. treasury yield and auction data, daily
foreign exchange data, U.S. and international index data, monetary and economic release data.

The MIM server/database resides locally (on-site) and is updated every hour by default. While all of LIM’s
clients receive the core data set, most of the clients select optional data packages that are relevant to their
particular industry. The core data set contains, among other date series, daily pricing data for all energy future
contracts, weather data and certain significant date data. For more information on the core and optional data
offerings, please see the "Data" section on www.lim.com.

http://www.lim.com
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Starting XMIM
For XMIM installation instructions, see the  Client Application Installation Guide. The following information
displays the first time XMIM is started and only needs to be entered once.

The first time you enter XMIM, an authentication message window displays as in the graphic below:

Select Yes if you want the authentication window to come up each time you start XMIM, select Always to
always authenticate the launching of XMIM (recommended choice – you won’t see this dialog again unless
XMIM is upgraded).

In order to run XMIM you will need to obtain a license key. Make a notation of the serial number listed in the
License Installation window (example below). You will need to send this serial number to a LIM Customer
Support Representative at support@lim.com to obtain a license key. (To contact Customer Support by phone
dial: U.S. Phone: 1-800-546-9646 ext. 3400, Europe Phone: +44 20 7190 2947 or U.K Free Phone: 0800 032
6063).

http://www.lim.com/pdfdocs/install_limapps.pdf
mailto:support@lim.com
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Use Ctrl+C and Ctrl+V to copy/paste the license key number into the License field.

Next, enter the server and port information:
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The XMIM interface displays.

The next time XMIM is restarted these screens will be by-passed. To change the server or port
settings, select Options>Connection>Server Config from the menu bar once the XMIM
interface displays.
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CHAPTER 2

Getting Started with XMIM

Objectives
1. How does the software work?
2. Introducing the Query Wizard and the Query Builder.

XMIM is a user friendly software program designed to query a comprehensive historical database that
includes, among other data series, security prices, volume, sentiment indicators, weather data and economic
indicators. There are two basic types of queries that can be created within the program: the SHOW/WHEN
query and the ORDER query.  

SHOW/WHEN allows you to ask what happens to the data series when certain conditions hold true. The
SHOW/WHEN query is an excellent research aid that allows users to understand, for example, how the
price of their securities reacted historically to certain market conditions. The other type of query, ORDER,
allows you to test trading ideas by placing buy or sell orders when certain conditions exist. Users often use
the analysis prepared in the SHOW/WHEN query to develop trading strategies within their ORDER block
queries.

A fast way to produce sophisticated queries for a new user to XMIM is to use the Query Wizard. This
wizard allows the user to create queries using predefined market and date events. The Query Builder
contains more advanced functionality and most of this book is dedicated to describing its features.
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Query Wizard Window

Select the  Query Wizard button. Use the Query Wizard to create a query using the prebuilt list of
market and date events. A user can go back and forth between the Query Builder and the Query Wizard to
construct a query.

Query Wizard SHOW Statement
In the SHOW statement portion of the Query Wizard window the following query statement is listed:

The Query Wizard allows you to easily identify the type of study you want to apply, what increment of time
should be studied and how far past your event dates the study should look. The fields are arranged so that a
very understandable phrase like "show what happened in terms of percent move to IBM every day over the
next two weeks" can be translated to the MIM query language.

The following describes each of the five fields going from left to right:

● The first field has a choice of: Total Return, Percent Move or Move from the pull-down menu. This field
will identify whether a total return, percentage move or move calculation is used to analyze the behavior
from the event date to past the event date.

● The second field is where you enter the symbol name of the instrument you wish to study. You can also use

the Search Database  button to locate the symbol of choice.

● The third field designates what increment of time you want to analyze the movement of the symbol after
the event dates. If you want to see what happens each day past the event date, this would be set to Days.
Alternatively if you wanted to see the movement every week this would be set to Weeks. Use the pull-
down menu to select Days, Weeks, Months, Quarters, Years, Calendar Days, Calendar Weeks,
Calendar Months, Calendar Quarters, Calendar Years.

● The fourth and fifth fields designate how far past the event dates you want the study to look. If you want
to study the 2 months past the event date set this to 2 months. The number entry is either typed into the
field or selected using the scroll arrows. Select the time period from the pull-down menu. The choices
are: Days, Weeks, Months, Quarters, Years, Calendar Days, Calendar Weeks, Calendar Months,
Calendar Quarters, Calendar Years.

Query Wizard SHOW Statement Example
Using the Query Wizard, it is possible to form a query that answers the following question:
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How have Crude Oil Futures performed in the past after seeing a very big one-day gain, (which is more than
two standard deviations stronger than the average one-day percentage change) which occurs three trading
days after an OPEC meeting?

The following shows the SHOW pane entries:

The following shows the completed SHOW statement in the Edit pane of the Query Wizard window:

   SHOW 
     t+1: percent_move from today to 1 day later  of CL  
     t+2: percent_move from today to 2 days later  of CL  
     t+3: percent_move from today to 3 days later  of CL  
     t+4: percent_move from today to 4 days later  of CL  
     t+5: percent_move from today to 5 days later  of CL  
     t+6: percent_move from today to 6 days later  of CL  
     t+7: percent_move from today to 7 days later  of CL  
     t+8: percent_move from today to 8 days later  of CL  
     t+9: percent_move from today to 9 days later  of CL  
     t+10: percent_move from today to 10 days later  of CL 

Query Wizard WHEN Statement
The following shows the date events and the market events that may be applied to your query as conditions.

Date Event Description
The date events are made up of date files that contain dates for the meetings, report releases or other events
that might affect the market. The date events allow users to anchor a variety of important market dates. The
date events are located under the Date Events pane of the Query Wizard window.

For a description of each Date Event, see the "Date Events" appendix in the XMIM User Guide.

Date Event Example
Below is an example of a date file:

20060131
20060228
20060328
20060425
20060530
20060627
20060725
20060829
20060926
20061031

http://www.lim.com/pdfdocs/xmimuser6x.pdf#Date_Event_Descriptions
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An example of the syntax resulting from selecting one of these events is displayed below.

   WHEN 
       Date is in "USA_TCB_Consumer_Confidence"

The syntax is saying the condition is true if the date is contained in the date file stored on the MIM server
called “USA_TCB_Consumer_Confidence”.

Market Event Description
Market events are pre-canned event conditions that can be easily added as WHEN statements to seek out
dates when a particular market event occurred. These market events have been provided to allow users of all
levels to write sophisticated queries without knowledge of the MIM query language. The market events are
located under the Market Event pane of the Query Wizard window.

For a description of the Market Events, see the "Market Events" appendix in the XMIM User Guide.

Market Event Example
For example, there is a market event available called Large five day decline located in the Big Moves folder
in the Market Event pane of the Query Wizard window. The definition of a Large five day decline is an
event where the closing price represents a five-day percentage decline of more than one standard deviation
below the average five-day percentage change measured over the last 30 trading days. The syntax (see below)
to accomplish this WHEN condition is somewhat complex and would typically take advanced XMIM query
knowledge to write.

   WHEN 
       5 value percent_move of TU  is less than 
       (30 day average of 5 value percent_move of TU   + 
        (1 * 30 day std_dev of 1 value percent_move of TU  
        )
       ) 

http://www.lim.com/pdfdocs/xmimuser6x.pdf#market_events_description
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Query Builder Window
The Query Builder window consists of the Edit pane and the SHOW WHEN panes. If you are familiar
with the query language, you may type a query directly into the Edit pane. The SHOW WHEN panes allow
you to create syntax through menu-driven selections. The following shows the components that make up the
SHOW and WHEN statement portions of the Query Builder window.

Query Builder SHOW Statement
To build a query from scratch, the user must enter a symbol and column and select the  Add Attribute to
Query   button. If you need to clear the Symbol and Column fields then select the  Restart Attribute

 button and start over. Once the Add Attribute to Query  button is selected, the query will display in
the  Editpane. Use the buttons listed under the SHOW statement portion of the Query Builder window to
modify the query. The following gives a description of the buttons and their functions. For more information
see the "SHOW/WHEN" chapter in the XMIM User Guide.

Table 2-1: SHOW Buttons

Studies A study is a mathematical or statistical calculation of a data series. Some of
the studies are macros which may be modified, saved and renamed using
the macro editor.

Arithmetic Operators Use the arithmetic operators: add, subtract, multiply, divide, power of to
accomplish any mathematical formula.

Attribute Units Attribute unit sets the default time frequency for any attribute expressions
built in XMIM.

Edit Rollover Use the choices in the Edit Rollover window to create custom futures
contracts.

Time Offset The Time Offset menu is used to pick a date, relative to 'today' or the
current date executed within the system.

Profit Loss Use the choices in the Profit Loss window to show statistics resulting
from an ORDER query block.

IF-THEN-ELSE Statement (SHOW) This language structure lets you assign values to your Attribute in the
SHOW statement based on time, date, event or price conditions.

Query Builder WHEN Statement 
Once the SHOW portion of the query is built, use the following buttons to build the WHEN portion of the
query statement. The following gives a description of the buttons and their functions. For more information
see the "SHOW/WHEN" chapter in the XMIM User Guide.

http://www.lim.com/pdfdocs/xmimuser6x.pdf#SHOWWHEN
http://www.lim.com/pdfdocs/xmimuser6x.pdf#SHOWWHEN
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Table 2-2: WHEN Buttons

Logical Operators Multiple WHEN conditions in your query can be linked together
into a complex condition using the And, Or, Xor, And Not, Or
Not, Xor Not logical operators.

Date Time Condition Use the settings in the Date Time Condition window to set
either date or time conditions. Use the date choices to set
historical date criteria. Use the time choices to set a particular
time or range of times during the trading day.

Custom Event Use the settings in the Custom Event window to search for
conditions, events and patterns in price series. This menu is
often used to specify certain market conditions.

Market Event The Market Event window contains predefined events created
by LIM.

IF-THEN-ELSE Statement (WHEN) This language structure lets you assign values to a condition
in your WHEN statement based on time, date, event or price
conditions.

Repeat This time saving feature is selected when you wish to repeat
the WHEN condition statement for a continuous period of time.
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CHAPTER 3

Event-Driven Analysis using the Query
Wizard Market Events

Synopsis

Objectives
1. Using the SHOW statement.
2. Using market events.
3. Using time offsets.
4. Manually editing the syntax.

Market Brief
Event-driven analysis is often used to predict what might happen in the future based on what has happened
in the past. Many analysts will do research to determine when a certain event or set of events occurred and
then study how the market reacted in the following hours, days, weeks, months, or further. The SHOW
WHEN query is designed to help the user answer the question what happened in the past when this event
occurred? Using the Query Wizard, it is possible to quickly and easily build and refine an event driven study.
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Problem
You will take a look at what's happened in the past to the 10-year US Treasury Bond Future when it crossed
above its 200-day average and 1 day ago the close experiences a large five day decline. Using the pre-built
SHOW statement, the query will calculate the percentage move from each of your event dates to 1, 2, 3,
4, and 5 days past the event date. The Market Event pane in the Query Wizard window lists a variety of
pre-canned conditions, including a "Large five day Decline", that can be added to the query as a WHEN
condition. You will select the market event called "Large Five Day Decline" and apply a time offset to specify
that this decline occurred in the 5 days prior to your event date. You will also select the market event called
"Cross above 200-day Moving Average" as your anchor event. After the query is completed, the following text
will appear within the Edit pane of the Query Wizard window:

   SHOW 
     t+1: percent_move from today to 1 day later  of TU  
     t+2: percent_move from today to 2 days later  of TU  
     t+3: percent_move from today to 3 days later  of TU  
     t+4: percent_move from today to 4 days later  of TU  
     t+5: percent_move from today to 5 days later  of TU  
   WHEN 
     1 day ago 
       5 value percent_move of TU  is less than 
       (30 day average of 5 value percent_move of TU   - 
        (1 * 30 day std_dev of 1 value percent_move of TU  
        )
       ) 
     AND 
       TU crosses above 200 day average of TU
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Step-by-Step Solution
Now you will step through the process of building this query using the Query Wizard.

1. Select the Query Wizard tab and in the SHOW pane select Percent Move from the first pull-down
menu. In the next field (the Symbol field) select the Search Database  button and select the Tree
View tab. Open the folders for Futures>Cbot then right-click on the symbol TU and choose Select and
Close to add the symbol to the SHOW statement and close the Search Database window.

2. Be sure that the field to the right of the symbol field is set to Days.

3. Next, in the SHOW pane change Over the next 1 Days to Over the next 5 Days by changing 1 to 5.
This will add new statements to the query (see below).

   SHOW 
     t+1: percent_move from today to 1 day later  of TU  
     t+2: percent_move from today to 2 days later  of TU  
     t+3: percent_move from today to 3 days later  of TU  
     t+4: percent_move from today to 4 days later  of TU 
     t+5: percent_move from today to 5 days later  of TU

4. For the WHEN statement, go to the Market Event pane and open the folder for Big Moves then select
the check box for Large Five Day Decline. Select the Occurred button and choose 1 Day Ago. The
query statement updates (see below).

   SHOW 
     t+1: percent_move from today to 1 day later  of TU  
     t+2: percent_move from today to 2 days later  of TU  
     t+3: percent_move from today to 3 days later  of TU  
     t+4: percent_move from today to 4 days later  of TU  
     t+5: percent_move from today to 5 days later  of TU  
   WHEN 
     1 day ago 
       5 value percent_move of TU  is less than 
       (30 day average of 5 value percent_move of TU   - 
        (1 * 30 day std_dev of 1 value percent_move of TU  
        )
       )

The Return  button will close the Occurred selection panel.

5. Next, as our anchor event, go to the Market Event pane and open the folder for Cross-overs then check
the box for Cross above 200-day Moving Average. This selection completes the query (see below).

   SHOW 
     t+1: percent_move from today to 1 day later  of TU  
     t+2: percent_move from today to 2 days later  of TU  
     t+3: percent_move from today to 3 days later  of TU  
     t+4: percent_move from today to 4 days later  of TU  
     t+5: percent_move from today to 5 days later  of TU  
   WHEN 
     1 day ago 
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       5 value percent_move of TU  is less than 
       (30 day average of 5 value percent_move of TU   - 
        (1 * 30 day std_dev of 1 value percent_move of TU  
        )
       ) 
     AND 
       TU crosses above 200 day average of TU
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Language Lesson
In this query, pre-canned event conditions were used from the Query Wizard. The definition of a Large five
day decline is an event where the closing price represents a five-day percentage decline of more than one
standard deviation below the average five-day percentage change measured over the last 30 trading days. The
syntax to accomplish this WHEN condition is somewhat complex and would typically take advanced XMIM
query knowledge to write.

   WHEN 
      5 value percent_move of TU is less than (30 day average of 5 value percent_move TU + ( 1 *
 30 day standard_deviation 
        of 1 value percent_move of TU))

This particular market event can be replicated in the Query Builder window using the Custom Event
button which will be introduced in a later chapter. These market events are provided to allow users of all
levels to write sophisticated queries easily. See the "Market Events" appendix in the XMIM User Guide for a
description of each market event.

http://www.lim.com/pdfdocs/xmimuser6x.pdf#market_events_description
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Problem Solvers
Create a query using the Query Wizard that shows what happens to the 30-year US Treasury Bond future
contract 1 week and 2 weeks later when the close price is up extra big and the day before it made a new 52-
week low.
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CHAPTER 4

Event-Driven Analysis using the Query
Wizard Date Events

Synopsis

Objectives
1. Using the SHOW statement.
2. Using date events.
3. Setting a date condition in the Query Builder.

Market Brief
Often important report release dates can have an affect on the market. For instance the Consumer
Confidence Index produced monthly by The Conference Board provides information on whether consumers
have a positive or negative outlook for the economy for the next six months. The theory is that if consumers
believe the economy looks good they will be more likely to spend more money on goods and services,
ultimately increasing the economy. It is sometimes meaningful to take a look at what happens to the market
when this report is released.
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Problem
This lesson will demonstrate what happened in the past to the S&P 500 GICS Consumer sector index when
the Consumer Confidence report was released in the fourth quarter during the heavy holiday shopping
season. Using the pre-built SHOW statement, the query will calculate the percentage move from each of our
event dates to 1, 2, and 3 weeks past the even date. The Date Event window contains a library of date files
containing important report release dates, meeting dates, or other dates that may affect the market. You will
select the Consumer Confidence report from the Date Events window. You will also add a condition that
will pull only dates in the fourth quarter from the Date Time Condition button in the Query Builder.

After the query is completed, the following text will appear within the Edit pane of the Query Wizard
window:

   SHOW 
     t+1: percent_move from today to 1 week later  of GICS500.25  
     t+2: percent_move from today to 2 weeks later  of GICS500.25  
   WHEN 
       Date is in "USA_TCB_Consumer_Confidence" 
     AND 
       Date is fourth quarter
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Step-by-Step Solution
Now you will learn the steps for creating this query.

1. To begin, select the  Query Wizard tab. In the SHOW pane select Percent Move from the first pull-
down menu. In the next field (Symbol field) select the Search Database  button and then select the
Tree View tab. Open the folders for Indices>S&P500GroupsGICS>FinancialsSector then right-click
on the symbol GICS500.25 and choose Select and Close to add the selection to the SHOW statement
and close the Search Database window.

2. In the next field in the SHOW pane, change every Days to every Weeks by selecting Weeks from the
pull-down menu. This completes the query statement portion from today to 1 week later.

3. The next portion of the SHOW pane Over the next 1 Weeks determines how many times the query
statement is going to display. Change 1 to 2 and note how the query statement changes:

   SHOW 
     t+1: percent_move from today to 1 week later  of GICS500.25  
     t+2: percent_move from today to 2 weeks later  of GICS500.25

4. Next, go to the Date Event pane and open the folders for Economic>United States>Government.
Check the box for Date is on USA_TCB_Consumer_Confidence.

5. The final query statement sets a condition that will pull only dates in the fourth quarter from the Date
Time Condition button in the Query Builder. To do this, select the  Query Builder tab and in the
WHEN pane select the Date Time Condition button then select the Date or Time button and choose
Date is from the pull-down menu. Select the within button and choose in Quarter>Fourth Quarter
from the pull-down menu. Select the OK button to close the Date Time window and return to the
Query Builder window. The following shows the completed query:

   SHOW 
     t+1: percent_move from today to 1 week later  of GICS500.25  
     t+2: percent_move from today to 2 weeks later  of GICS500.25  
   WHEN 
       Date is in "USA_TCB_Consumer_Confidence" 
     AND 
       Date is fourth quarter
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Language Lesson
This query utilizes the Date Events in the Query Wizard. The date events are made up of date files that
contain dates for the meetings, report releases or other events. Below is an example sample of a date file.

   …20060131
   20060228
   20060328
   20060425
   20060530
   20060627
   20060725
   20060829
   20060926
   20061031…

The syntax resulting from selecting one of these events is displayed below.

   WHEN   
       Date is in "USA_TCB_Consumer_Confidence"

The syntax is saying the condition is true if the date is contained in the date file stored on the MIM server
called _TCB_Consumer_Confidence. This might explain why the syntax does not more directly state Date
is Consumer confidence release date.

You also practiced going to the Query Builder to add a condition. Any attribute or condition can be added
to a query built with the Query Wizard.
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Problem Solvers
Create a query using the Query Wizard that shows what happens to the NASDAQ index each day over the
next 3 days when the FOMC has a meeting.
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CHAPTER 5

Basic Pricing Graphs

Synopsis

Objectives
1. Introducing SHOW attributes.
2. Using continuous futures contracts.
3. Executing a query.
4. Restarting or saving a query.

Market Brief
The most commonly used market research tool is a price graph or chart. Price graphs may be employed to
determine where the current price of a security is in relationship to the prices the security made for some
relevant period of time by displaying the historical activity for a security. For example, did the security reach
a new 1-month high or is the security priced uncommonly low compared to the prices attained over the last
year?

 The “Money & Investing” section of The Wall Street Journal contains price graphs for certain major investment
sectors. For example, this newspaper will graphically display the daily closing price for the Dow Jones
Industrial Average for the last two calendar years. XMIM allows a user to construct this type of research by
building a query. The type of query that graphs price history for an investment is easy to construct. Queries,
as mentioned earlier, are English-like questions created about a database consisting of time series data. In the
XMIM language the query will SHOW the daily closing price of a security WHEN the date falls within the
last two years. Using a SHOW attribute in the Query Builder to build this query, it is necessary to select the
symbol (the security of interest) and the column or data series that relates to that symbol (the closing price).
This combination of a symbol + a column is a complete description of a times series and the simplest form
of what will be referred to as an attribute. Next, the query can be limited to some relevant period of time (e.g.,
within 2 years) by adding a date condition to the query. These concepts will become clearer as you continue to
work through the materials in the manual.
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Problem
You can create a similar graph for our security of interest. A commonly traded over the counter (OTC)
security is the 30-year U.S. Treasury Bond. For this lesson, you will create an historical graph of the daily
closing yield of the 30-year U.S. Treasury Bond. XMIM data for OTC instruments will commonly have an
“Open”, “Close”, “High” and “Low” for the security. Because a proper ‘exchange’ doesn’t exist for OTC
instruments, the prices are sampled at certain relevant hours of operation. For example, U.S. Domestic OTC
instruments would be sampled during normal U.S. trading hours. The query, when executed as a graph, will
display every closing yield for the ‘on the run’ or most recently auctioned 30-year U.S. Treasury Bond. This
graph will consist of several different securities over time.

In order to construct this type of query, you will use the SHOW/WHEN query block to define a simple
SHOW attribute. This query will SHOW the daily closing yield for the 30-year U.S. Treasury Bond. A query,
such as the one used in this lesson, that has a SHOW attribute without a WHEN condition will return all
values available for the attribute from the database. The addition of a WHEN condition to a query will simply
narrow down the data population.

After you have completed the query, the following text will appear within the Edit pane of the Query
Builder window:

   SHOW 
     1: Close of USC30 
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Step-by-Step Solution

Choosing the Symbol and Column of Interest
1. We need to define our SHOW attribute by defining our symbol and column of interest.

2. To add a Symbol name you can either enter the symbol of interest by typing it into the text field located
next to Symbol or by selecting Search Database icon to look up the symbol. The Search Database is
used like a dictionary look-up feature and will allow you to easily find the proper symbol name. For this
example, select the Search Database  icon to look up the symbol.

3. In the Search Database window under the Tree View tab, open the folders for EconomicIndicators
> USA_Economic > US_GovtYields. Notice that with each subsequent selection, the directory path
displays at the bottom of the window. 

4. Select USC30, right-click and choose Select to complete the symbol selection. The symbol and its default
column are entered in the Query Builder. Notice that the description of the contract appears in the
description field to verify that the correct selection was made.
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Select OK to close the Search Database window and return to the Query Builder window.

5. The selected symbol should now appear in the Symbol text field.

6. The next step involves selecting the data series or column that relates to the symbol. The software will
default to the most commonly used column, such as the Close, where no column is specified. To specify
a column, select the pull-down for the Column field and select a column. For this example, keep the
column Close. Select the Add Attribute to Query  button to add the SHOW statement to the Edit
pane.
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Executing the Query
1. The results of the newly-created query may be obtained by selecting the Report  or Graph  buttons

located in the toolbar. First, select the Report  button. Notice that the results are displayed in tabular
format. All dates, which have a closing price for the security in the database, will be listed on the left-most
column and the closing price for the 30-year U.S. Treasury Bond Yield listed in the column to the right of
the date. If a WHEN condition was added to the query, only those dates that met that condition would be
returned.

Notice that a few dates reflect NaN in the close column. NaN stands for not a number and will appear
anytime a price is not available because the markets are closed (i.e., a holiday) or the designated data
vendor did not supply this data. Notice that a few descriptive statistics appear at the bottom of our report
to categorize our data population.
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2. Select Dismiss at the bottom of the Report window and select the Graph  button from the toolbar to
see the answers displayed graphically (see below).

Select the Dismiss button to close the graph and return to the Query Builder.

The Options button in the Graph window controls the display settings for the graph.
These option settings are defined in the "Analysing Your Research Results" chapter in the
XMIM User Guide.

Restarting or Clearing the Edit Pane

To clear the Edit pane for the next query, select the New   button from the toolbar. You will be prompted
about saving the query. For this lesson, select No to clear the Editpane.

http://www.lim.com/pdfdocs/xmimuser6x.pdf#Analyzing_Your_Research_Results
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Language Lesson
The SHOW/WHEN query allows a user to question what happens to the market when certain conditions are
present. A query may be constructed by either making certain menu selections in the Query Builder window
or by typing the query directly into the Edit pane.

The format for the SHOW/WHEN query is:

   SHOW
      1: (Column) of (Symbol)
   WHEN
      Defined conditions are true

An attribute is a complete description of a time series. An attribute is any expression that, when interpreted,
represents a series of values arranged chronologically into an array or matrix. An attribute is represented in
XMIM by a unique identifier call a symbol. For example, CPQ represents COMPAQ stock and US represents
the U.S. 30-year Treasury Bond Futures contract. Symbols are organized in the database in hierarchical or tree
fashion by certain major market categories.
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Problem Solvers
1. Construct a query that will graph the closing yield for the U.S. 10-year Treasury Bond.

2. Construct a query that will graph the opening price for the U.S. 30-year Treasury Bond futures contract.



XMIM FINANCIAL TRAINING GUIDE
Chapter 6: Limiting the Graph to a Relevant Period of Time

35
 

CHAPTER 6

Limiting the Graph to a Relevant Period of
Time

Synopsis

Objectives
1. Limiting the attributes using the WHEN date condition.
2. Multiple SHOW attributes.
3. Using compound attributes.
4. Introduction to the arithmetic operator.

Market Brief
Investors examine price history for some significant period of time, such as a 52-week chart or a 6-month
chart. Price history is commonly viewed in bar charts, although many chart traders may prefer to use only
closing prices for their price graphs. A graph that uses a daily bar represents the opening price with a left
horizontal mark, the close by a right horizontal mark and the two daily extremes of the high and low and as
the top and bottom of a vertical line. The difference between the extreme points on the bar is the daily price
range for the security. Some investors prefer to view the range as a value separate from the bar chart. Certain
traders maintain that when a security trades within a tight range for a period of time (where the daily range is
much smaller than usual for some period of time), a price breakout to the up or downside is expected.

To confine the period of time that the attribute will be shown, it is necessary to construct a WHEN
condition. The WHEN condition provides the ability to confine the results of the query or “question about
the markets” to specific dates and times of interest. It was mentioned earlier that XMIM’s language structure
for the SHOW/WHEN query, is SHOW my security WHEN certain conditions are met. What is it that you
would like to see WHEN those conditions are met? You would like to see both a bar chart (the open, close,
high and low prices for our security) and the daily range for your security.
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Problem
For this lesson, you will create an historical bar chart for GII.IBM.NYSE stock and the daily range associated
with the stock for each day within the last year of trading. You will capture the daily price bar (open, high,
low and close) and the range (the high of the day minus the low) for each day. In order to construct this type
of query it will be necessary to use the SHOW/WHEN query block. Using the SHOW/WHEN query, you
will need to define a SHOW attribute and a compound SHOW attribute (constructed as <SHOW Attribute>
<Arithmetic Operator> <SHOW Attribute>).

After the query is completed, the following text will appear within the Edit pane of the Query Builder
window:

   SHOW 
     1: Bar of GII.IBM.NYSE 
     2: High of GII.IBM.NYSE - Low of GII.IBM.NYSE 
   WHEN 
       Date is within 1 year
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Step-by-Step Solution
1. You need to create two separate SHOW attributes for this query. Begin by creating the first attribute,

Bar of GII.IBM.NYSE. Select the Search Database  button then select the Tree View tab. Locate the
symbol GII.IBM.NYSE by opening the folders for Equities > GlobalInsight > Nyse > Tickers > i >
ib. Right-click on the GII.IBM.NYSE symbol and choose Select to add the symbol. Select OK to close
the Search Database window and return to the Query Builder window.

2. Upon completion of the symbol, the Symbol text field should have GII.IBM.NYSE highlighted and
a description of the contract. Instead of using Close, you will select Bar from the Column pull-down
menu.

3. Select the Add Attribute to Query  button to add the attribute to the Edit pane. The Edit pane will
contain the first SHOW attribute portion of the query.

4. The next SHOW attribute is actually a compound attribute: High of GII.IBM.NYSE – Low of
GII.IBM.NYSE. This attribute will require selection of two attributes and the use of an arithmetic operator.
Select GII.IBM.NYSE as the symbol using the Search Database  button or type GII.IBM.NYSE into
the Symbol field. Select High from the Column pull-down menu.

5. If you were to accept the information currently selected in the SHOW pane, you simply see the high price
for the IBM contract. You want to see the difference, however, between the high and the low. In order to
accomplish this task you will need to use an arithmetic operator to link the two attributes together (High
of GII.IBM.NYSE – Low of GII.IBM.NYSE ). To do this, select the Arithmetic Operator  button and
select the Radial button for Subtract.

6. The Arithmetic Operator pane in the window becomes ghosted (inactive) and the SHOW pane in
the window becomes active. In this SHOW pane you will enter the Low of GII.IBM.NYSE portion of
your compound attribute. Type GII.IBM.NYSE into the Symbol field and choose Low as the Column to
complete the attribute. Select the Add Attribute to Query  button to add the compound sentence High
of GII.IBM.NYSE – Low of GII.IBM.NYSE to the Edit pane and return to the Query Builder window.
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The following shows the query so far.

   SHOW 
     1: Bar of GII.IBM.NYSE 
     2: High of GII.IBM.NYSE - Low of GII.IBM.NYSE 

Refining the Pricing Graph in the WHEN Condition
1. The WHEN condition provides the ability to restrict the results of the query to specific dates or times

of interest. For our pricing graph you want to restrict the time period, for which you will SHOW your
attributes, to the last year.

2. In the WHEN pane of the Query Builder, select the Date Time Condition button. From the Date
Time Condition window, select the Date or Time button and select Date is from the items listed. 

The first four items listed are date condition selections, the next four are time condition
selections.

3. Within 1 day will appear in the Date Time window and it will be necessary to change day to year in the
pull-down menu in order to complete our date condition. If the Date Time Condition window has Date
is within 1 year highlighted, select OK to complete the date condition.
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4. Notice that the query in the Edit pane now contains the two SHOW attributes along with a WHEN
condition. The WHEN condition limits the period of time that the SHOW attributes (the Bar and daily
range of GII.IBM.NYSE) is displayed to the last year. Select the Graph  button from the toolbar to
graph the query.

5. To improve the clarity of the graph, you will use the graphic options to partition the attributes. Select
the Options button at the bottom of the Graph window. There are several graphic options available to
change to appearance of the graph.

For this lesson, you are limiting the first SHOW statement to the top quadrant of the graph (1: Bar
of GII.IBM.NYSE) and the second SHOW statement to the bottom quadrant of the graph (2: High of
GII.IBM.NYSE - Low of GII.IBM.NYSE). Under the Attributes pane of the Graph Options window, select
the 1 (label) button to bring up the 1 (label) window .

From the 1 (label) window, type 60 in the View (bottom) text field in the lower right hand corner of the
display. The View option may be used to limit the display of attributes to certain quadrants of the graph.
If the 1 (label) window has 25 in the View (bottom) text field and 100 in the View (top) text field, select
OK to return to the Graph Options window.

Next select the 2 (label) window, type 40 in the View (bottom) text field in the lower right hand corner
of the display. Keep the 100 View (top) setting. Select OK to close the 2 (label) window and select OK to
close the Graph Options window. The graph now is sectioned into two quadrants:
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Language Lesson
You have now completed a basic price graph by specifying what attributes you want to SHOW, WHEN
certain date conditions are met. The execution units (select Options>Execution Units from the menu
bar) are set to check the date condition on a daily basis. The attributes display for those days that meet the
condition.

There may be several different attributes or markets of interest that a user could SHOW in a query for certain
defined conditions. XMIM automatically assigns a numerical label to each attribute, so as to avoid confusion
when the answers to a query display. For the example above, the first label appears as 1: and the second as 2:.
You may change the label by editing the query in the Edit pane to give the attribute a proper name such as
Bar_GII.IBM.NYSE. The assigned label can be any text and number combination as long as there are no spaces
between the characters used in the label.

Attributes may be represented by a single time series (e.g., the closing price of IBM or Close of GII.IBM.NYSE
in the XMIM language) or by multiple time series (e.g., the High of GII.IBM.NYSE - Low of GII.IBM.NYSE
or the daily range of IBM). Attributes can be combined using simple arithmetic operations like addition and
division, or complex functions such as correlation.

Conditions are added to a query by making selections from the Date Time Condition, Custom Event or
Market Event buttons in the WHEN pane of the Query Builder window. In this lesson, you used the
date condition date is within 1 year. Notice some of the other selections available in the Date Time
Condition window when the within choice is selected. You can select specific events such as is known
date>election>Presidential Election Year.



42
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 6: Limiting the Graph to a Relevant Period of Time

Problem Solvers
1. Construct a query to graph the Bar and range of Dell Computer Corporation stock for the last 2 years.

2. Construct a query to graph the Bar of the front S&P futures contract as well as the daily range for the last
52 weeks.

To locate the symbol, select the Search Database  button then select the Tree View
tab and open the folders for Futures>Cme>s.



XMIM FINANCIAL TRAINING GUIDE
Chapter 7: Using a Technical Indicator with a Price Graph

43
 

CHAPTER 7

Using a Technical Indicator with a Price
Graph

Synopsis

Objectives
1. Introducing studies.
2. Introducing graphic options.
3. Reiterating date conditions.

Market Brief
Price graphs, like those used in the Wall Street Journal or other financial periodicals, are helpful aids used
to determine where the current price of a security is in relationship to the prices the security traded at for
some relevant past period of time. Researchers commonly employ the same technique to certain basic
mathematical formulas. These formulas may be used to define trends based on changes within the formula’s
value relative to some previous period. When studying the price trend of two or more related securities, it is
sometimes helpful to employ a moving correlation study to better understand the change in price of a security
relative to the other. A correlation study may be employed with the price series as an aid in determining price
movement.
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Problem
In this lesson, you will display the closing price for both the 30-year U.S. Treasury Bond futures contract and
the S&P futures contract along with a one-month moving correlation study of both pricing series for the last
two years.

The following text is in the Edit pane of the Query Builder window upon completion of the query:

   SHOW 
     SP: Close of SP 
     US: Close of US 
     Correlation: 1 month correlation of Close of SP and Close of US  
   WHEN 
       Date is within 2 years 
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Step-by-Step Solution

Selecting the Attributes
1. This lesson requires a correlation study of two attributes along with the price history for those attributes.

Begin by creating the Close of the S&P 500 Futures. To do this, select the Search Database  button
find the S&P 500 Futures in the Tree View. If the directory path is still pointing to the last lesson's path,
close the directory folders until you are at the topmost folder. Open the folders for Futures > CME
then highlight the symbol SP, right-click and choose Select to add the selection SP and Close to the
SHOW statement in the Query Builder window. Select OK to close the Search Database window and
then select the Add Attribute to Query   button to add the SHOW statement to the Edit pane of the
Query Builder window.

2. Use proper labels for your attributes, so highlight the label 1: in the Edit pane and type the name SP:.

   SHOW 
     SP: Close of SP

3. Using the Search Database  button (Tree View tab), find the symbol US for 30 Year U.S. Treasury
Bonds Futures by opening the folders Futures > Cbot then highlight the symbol US, right-click and
choose Select to add the selections US and Close to the SHOW statement in the Query Builder
window. Select OK to close the Search Database window then select the  Add Attribute to Query  
button to add the SHOW statement to the Edit pane of the Query Builder window.

4. Use proper labels for your attributes, so highlight the label 1: in the Edit pane and type the name US:.

   SHOW 
     SP: Close of SP 
     US: Close of US 

5. You will now create the one-month correlation study of the S&P 500 Futures and the 30 Year U.S.
Treasury Bonds Futures. XMIM has over 100 different studies available to use with the data series. A
study is a mathematical or statistical calculation of a data series. The result of the addition of a study to
an existing defined symbol and column is the creation of a new data series. Examples of commonly used
studies are: moving averages, highest high and lowest low calculations, correlation and co-regression.

For the study you are going to use the correlation study. The first step is to enter the symbol SP into the
Symbol field and keep the default column Close. To choose this study, select the Studies  button in
the SHOW pane of the Query Builder window then choose correlation from the list and select OK.
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The Study: correlation window opens. 

6. The attribute for Series1 is already populated with the SP symbol and Close column (entered from the
SHOW pane). To define the US attribute, select the Attribute button located next to next to Series2
and enter US for the Symbol and select Close for the Column then select OK to return to the Studies:
correlation window. Lastly, define the period of time for the study by selecting the Time Period button.
1 day is the default period of time. Change Days to Months and select OK to return to the Studies:
correlation window. Select OK to return back to the Query Builder window. Notice that the Studies 
button is highlighted . Select the Add Attribute to Query  button to add the correlation study to the
SHOW statement in the Edit pane.

7. You are going to use proper labels for your attributes so highlight the label 1: in the Edit pane and type
the name Correlation. The following shows how the query should look:

   SHOW 
     SP: Close of SP 
     US: Close of US 
     Correlation: 1 month correlation of Close of SP and Close of US
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Refining the Price Graph

WHEN (Condition)
1. In the WHEN pane of the Query Builder window, select the Date Time Condition button then select

the Date or Time button. You want to specify Date is and within 2 years. First select Date is from the
pull-down menu then change 1 to 2 and day to year. If the Date Time Condition window has Date is
within 2 years select OK to complete the date condition. The following shows the completed query:

   SHOW 
     SP: Close of SP 
     US: Close of US 
     Correlation: 1 month correlation of Close of SP and Close of US  
   WHEN 
       Date is within 2 years 

2. Select the Graph  button from the toolbar to graph the query. Note that the study will return the
statistical correlation coefficient between the two time series over a 1 month moving time window. This
study returns values between the range of 1 (perfect correlation) and -1 (perfectly negative correlation).

3. To improve the clarity of the graph, you will use the Graphic Options to partition the attributes. Select
the Options button at the bottom of the Graph window. There are several graphic options available to
change to appearance of the graph.

For this lesson you are limiting the correlation study to the bottom quadrant of the graph. Under the
Attributes pane of the Graph Options window, select Default to bring up the Default Options
window that corresponds to the whole graph.

From the default window, type 25 in the View (bottom) text field in the lower right hand corner of the
display. The View option may be used to limit the display of attributes to certain quadrants of the graph.
If the default window has 25 in the View (bottom) text field and 100 in the View (top) text field, select
OK to return to the Graph Options window.

4. Next, under attributes select Correlation to bring up the correlation window that corresponds to the
attribute labeled Correlation. Type 20 in the View (top) text field. If the correlation window has 0 in the
View (bottom) text field and 20 in the View (top) text field, select OK to return to the Graph Options
window. Select OK to change the graphic options.

5. XMIM only has the capability to show two-reference axis at one time. If you are using multiple data series
in the graphs, select on the data series of interest to change to reference axis. Each axis will retain the
color of its respective data series.
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The chart shows the final result of your query, displaying the correlation study in the bottom quadrant of
the window.
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Language Lesson
You have now completed a basic price graph with a technical study overlay by specifying a study of an
attribute.

 Studies are mathematical, statistical, and date functions that are compiled into the XMIM code for speed.
Server macros, which are included in the studies list, provide calculations reduced down to a single statement
in the query language. Unlike the other studies, however, server macros exist outside of the program code,
and can be created, edited and modified by the user with a simple text editor. These server macro files are
located in the xmim/library directory within the attr and column sub-directories. Server macros tend to
include more advanced technical indicators, statistical, and astrological calculations. For a detailed description
of the studies and server macros, see the "Studies and Server Macros" chapter in the XMIM User Guide.

 With regard to time expressions used within XMIM studies, there are two ways to specify the time period
for a study. The default method is to specify a number (n) and a calendar measurement or some ‘time unit’
expression (i.e., day, month, year or quarter) in the top most area of the Time Period window. For example,
you can specify a time period such as:

● “10 day” (where 10 represents the number and day refers to the time-unit); or
● “9 value” (where 9 represents the number specified and value is the time-unit that refers to actual values

available in the data series); or
● “30 minute” (depending upon the symbol used there may be intraday studies available); or
● “10 calendar year”.

The time unit is defaulted to day but may be changed by pulling down the menu and selecting a different
time unit. This default method will include all dates extending back from the current calculation date to some
point back in time as in the expression. The other method of specifying the time period is to use the From-
To buttons in the Time Period window. These buttons allow you to specify exactly the ending and starting
points of the window by making selections from the pull-down menu. The selections available for either
button are: Today, Begin of Time/End of Time, Time Offset or Condition. Usually you will want the From
date or the To date to be Today.

http://www.lim.com/pdfdocs/xmimuser6x.pdf#studies_and_server_macros
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Problem Solvers
Create a 2-week correlation study of the close of the Dow Jones Industrial Average Index (DJIA) and
NASDAQ Composite Share Index (NASD) for the last 6 months.

To locate these two symbols, select the Search Database  button then select the Tree View
tab. Open the folders for Indices > U.S.Indices.
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CHAPTER 8

Basic Event-Driven Analysis using Date
Conditions

Synopsis

Objectives
1. Reiterating studies.
2. Setting a time offset.
3. Introducing the condition connector.
4. Using date files within the date condition.

Market Brief
Seasonality studies are commonly used as a research device to analyze price patterns surrounding certain time
periods. For example, what happens to stock prices during the month of January or at year-end or to bond
prices after the release of an inflationary economic number? Oftentimes, a researcher will employ a price
graph to analyze price patterns surrounding certain significant dates. XMIM has the ability to supplement this
technique by identifying certain significant dates through the use of the WHEN condition and analyzing the
price movement for those dates using the SHOW attribute.
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Problem
For this lesson, isolate those periods of time within the last fifteen years when there was an employment
release (USA BLS Nonfarm Payroll). Using this date as an anchor date, calculate the move in the 30-year
U.S. Treasury Bond futures contract from the anchor date until one day later. In the XMIM language, what
you want to SHOW is the 1 day move of the close of the U.S. Treasury Bond WHEN the date is a USA BLS
Nonfarm Payroll release date within the last fifteen years. After the query is completed, the following text will
appear within the Edit pane of the Query Builder window:

   SHOW 
     1: percent_move from today to 1 day later  of Close of US  
   WHEN 
       Date is within 15 years
     AND 
       Date is in "USA_BLS_Nonfarm_Payroll"
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Step-by-Step Solution

Selecting the Study of an Attribute
1. The SHOW attribute used in this lesson involves a study of an Attribute. Bring up an Attribute Window

by selecting the SHOW Attribute button. From the Attribute Window select the Search Database 
icon to find the 30 Year U.S. Treasury Bonds Futures contract under the Futures > Cybot folders; or,
type the symbol US into the text field next to Symbol.

2. We will keep the default column Close for this example.

3. If you select OK at this point you see the sampled closing price for the U.S. Treasury Bond. However,
what you want to do is to create a study on that price series. Select the Studies button from the SHOW
statement portion of the Query Builder. From the Studies list select % move.

4. Within the Study: % move window, select the Time Period button. Then select the radial button next to
From. The default selection is Today. Today is a generic concept in XMIM and will take on the date that
meets the WHEN Condition. Keep the Today selection.

5. Also keep the default settings of 1 Day Later. Select OK to return to the Study: % move window. The
Study: % move window should now have From: Today and To: 1 Day Later highlighted. If it does,
select OK to return to the Query Builder.

6. The study of the attribute is now complete. Notice that the Studies  button is highlighted. Select the
Add Attribute to Query  button to add the study information to the query in the Edit pane.

   SHOW 
     1: % move from today to 1 day later  of Close of US

Refining the Price Analysis in the WHEN (Condition)
If we were to execute the query with just the SHOW portion completed, the day move would be displayed for
all available dates within the database. However, we only want to see the one day move that occurs following a
Nonfarm release after 1990. In other words, we want to restrict results of our query to a specific set of market
dates.

1. In the WHEN pane of the Query Builder, select the Date Time Condition button then select the
Date or Time button.

2. We want to specify Date is within 15 Years. In order to create this query select Date is from the pull-
down menu. Keep the within button selection and change 1 Day to 15 Years. The Date Time window
should have Date is within 15 Years highlighted.
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3. Next, add another date condition by selecting the Add Condition  button. There are two types
of date criteria available: generic calendar dates that might be found on any calendar and special date
events that are specific to the investment community. To add the date event condition: Date is in
"USA_BLS_Nonfarm_Payroll" keep the AND logical operator then select the the Date or Time button
and choose Date is from the list. Next, select the within button and choose in file>server file from
the list. To locate the USA_BLS_Nonfarm_Payroll date event select the Browse button and open the
folders for Economic>UnitedStates>Government and choose USA_BLS_Nonfarm_Payroll from
the list. Select OK to close the Browse window. If the Date Time Condition window shows Date is in
"USA_BLS_Nonfarm_Payroll" then select OK to close the Date Time Condition window.

The Refresh Condition  button will refresh the Date Time Condition window so
that a new date or time condition can be constructed.

4. Your query is now complete:

   SHOW 
     1: percent_move from today to 1 day later  of Close of US  
   WHEN 
       Date is within 15 years
     AND
       Date is in "USA_BLS_Nonfarm_Payroll"

Graphing the query would give us a nonsensical chart; so, instead select Report from the toolbar to view
the tabular results of the query. As mentioned earlier the left column represents the corresponding dates
that meet our conditions and the furthest right column is the study of the data series or attribute. At the
bottom of the report is statistical information about the entire population of the results.

5. Select Dismiss to close the Report window.

6. The next two lessons will build upon this query so we will have to Save the language of this query before
selecting New to work on the Problem Solvers.
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Language Lesson
In this lesson we reviewed a basic mode for event-driven analysis by creating a study of an attribute using the
time offset feature. Additionally, we created a compound condition using the logical operator "AND" within
our query.

There are two ways of specifying the time period for a study. The default method is to specify a number (n)
and a calendar measurement or some ‘time unit’ expression (that is day, month, year or quarter) in the Time
Period window. For example, you can specify a time period such as 10 day (where 10 represents the number
and day refers to time unit) or 9 value (where 9 represents the number specified and value is the time unit
that refers to actual values available in the data series) or 30 minute (depending upon the symbol used there
may be intraday studies available) or 10 calendar year. The calculation window using the default method
will include the dates extending back from the current calculation date to the point back in time specified
in the time period expression. The other method of specifying the time period, which we used in the lesson
above, is to use the From-To Time button located in the Time Period window. These buttons allow you to
specify exactly the ending and starting points of the window by making selections from the pull-down menu.
The selections available for either button are: Today, Begin of Time/End of Time, Time Offset or Condition.
Usually you will want the From date or the To date to be Today. Remember that Today is a generic term in
XMIM and will take on the date of the calculation.
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Problem Solvers
1. Create a study that analyzes the 1-day percent move of the 30-year U.S. Treasury Bond futures contract

following all a Nonfarm economic release falling after 1993.

2. Create a study that analyzes the 1-week move of the front S&P futures contract leading up to all U.S.
holidays.
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CHAPTER 9

Basic Event-Driven Analysis using Market
Conditions

Synopsis

Objectives
1. Reiterating studies.
2. Limiting the attribute using the WHEN condition custom event.

Market Brief
In the previous lesson, we mentioned that in reviewing a price graph it is possible to note certain changes in
the price of securities associated with major market dates. What if, instead of focusing on a market date in the
query, we described the price movement of the security as a condition that had to be met in order to SHOW
our defined attribute. In other words what if we isolated those dates that made certain price movements and
reviewed the price action of our security following the defined trend? This sort of analysis is done all the time
in market industry periodicals. It is not uncommon for the Wall Street Journal or other newspaper to carry
headlines that read “Stocks Plunge 300 points, Year's Worst Fall…Should We Expect a Rebound?" Wouldn’t
it be interesting to isolate those dates in the past when the market sold off by a similar amount to see what
happened to the price of the security?
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Problem
Using the previous lesson, what would happen to the results of our query if the actual economic release
comes in higher than the consensus estimate?

In the XMIM language, you want to SHOW the 1-day percent move in the 30 year U.S. Treasury Bond futures
contract WHEN the date is a USA BLS Nonfarm Payroll release date after 1990 and the actual economic
release is more than the consensus estimate. After the query is completed, the following text appears within
the Edit pane of the Query Builder window:

   SHOW 
     1: percent_move from today to 1 day later  of Close of US  
   WHEN 
       Date is after 1990 
     AND 
       Date is in "USA_BLS_Nonfarm_Payroll" 
     AND 
       _Implicit_ of NONFARM_ACT is more than _Implicit_ of NONFARM_EST
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Step-by-Step Solution

Selecting an Additional Condition
1. You want to add another condition to the existing saved query used in the previous lesson. Open the

saved query used in the last lesson.

2. Select the condition connector And then select the Custom Event button located in the WHEN pane of
the Query Builder to build the custom event condition.

3. There are two ways to build a custom event condition. Custom event conditions are often used to
compare an attribute to another attribute or to compare the attribute to a constant or variable (normally
a number representing price). A custom event condition may be built by completing either two panes of
the Custom Event window (the left attribute and a conditional operator) or by completing three panes
of the Custom Event window (the left attribute, a conditional operator and the right attribute). For this
query, you will use all three panes of the Custom Event window: the _Implicit_ of NONFARM_ACT
(this is the complete information in the Left Attribute portion of the window) is more than (this is the
complete information for the Conditional Operator) the _Implicit_ of NONFARM_EST (this is the
complete information for the Left Attribute window).

4. In the Custom Event window, for the Left Attribute, type in NONFARM_ACT into the text field next to
Symbol or use the Search Database icon and the Tree View to locate the symbol in the folder path:
EconomicIndicators > USA_Economic > USA_Actual. The column _Implicit_ is the only column
selection available. If the Left Attribute has NONFARM_ACT and _Implicit highlighted, select the
Continue button.

5. Remember that we need to fill out three panes. The next portion of the Custom Event window to
complete is the Conditional Operator. You are comparing the closing price of our security with its price
at the open by using the Conditional Operator. Change the Conditional Operator from is exactly to is
more than and then select the Continue button.

6. The last area you need to complete is the custom event condition in the Right Attribute pane.
Remember, the condition will be met if the _Implicit_ of NONFARM_ACT is more than _Implicit_
of NONFARM_EST. The first two panes completed so far are _Implicit_ of NONFARM_ACT is
more than. To complete the sentence within the final or Right Attribute, type in NONFARM_EST in the
text field next to Symbol (the only Column available is _Implicit_). If the final Right Attribute has
NONFARM_EST and _Implicit_ highlighted, select OK.

7. Select the Report  button in the toolbar to produce the report. Notice the difference in statistics of
our results from the previous lesson. By including an additional market condition we have decreased the
number of results but also we have changed the number of positive results.

When creating queries, add the conditions one at a time to see what effect each additional condition has
on the answer population.
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Language Lesson
In this lesson, we reviewed the effect of including a market condition using a custom event on the population
of our results.

There are many places in the XMIM language where attributes can be selected for use. A left or right attribute
pane indicates that you can build an attribute expression in the query syntax at that point. The SHOW part
of a SHOW / WHEN query is a typical place to use an attribute expression. Often, you are trying to produce
results based upon certain conditions or patterns in the market. In order to do this, it is necessary to reference
or compare the attribute to some other attribute or constant by creating a WHEN condition. Stated another
way, users often want to SHOW an attribute WHEN the attribute has reacted in some specified pattern.

The custom event condition's general format is as follows:

<Left Attribute> <Conditional Operator> <Right Attribute>

The format is rather simple to understand: some specified attribute, (left attribute) does something in
comparison to, i.e., is more than (conditional operator) some other specified attribute, (right attribute).
For convenience, the Conditional Operator pane of the Custom Event window contains some terminal
selections that are shortcuts taking away the need to specify a right attribute. Thus, in some instances it is
possible to form a complete condition using just the <Left Attribute> and the <Conditional Operator>.
Whenever you finish an pane in the Custom Event window by selecting Continue the next pane becomes
active in natural sequence to finish the menu construction of the condition.

Most of the functions available in the Conditional Operator window are pretty self-explanatory. However,
the function is defined or is not defined located in the second line bears review. Both of these conditional
operator options allow you to test whether a value exists for a specified attribute. An attribute is not defined
whenever the results of execution of the query would be NaN (not a number), i.e., if there is no value in the
database for the specified attribute. A few of the data series in the database may be missing data because of
the nature of the series (i.e., the data available in the market is scarce or not provided by many data suppliers.)
As a matter of preference, you may choose to disregard certain series that are missing data. The easiest way to
identify missing data is to use the is not defined function.
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Problem Solvers
1. Create a study that analyzes the 1-day move of the French Franc, following all Producer Price Index

release dates falling after 1995 whenever the actual Producer Price Index release is less than the consensus
estimate.

2. Create a study that analyzes the 1-week move of the 30 year U.S. Treasury Bond following all Home Sales
release dates within the last 3 years whenever the actual Home Sales release is less than the consensus
estimate.
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CHAPTER 10

Event-Driven Analysis using Weather Data

Synopsis

Objectives
1. Using the WHEN condition repeat function.
2. Reiterating the use of multiple conditions.
3. Introducing geophysical data.
4. Introducing execute options.

Market Brief
There are two basic schools of market analysis: technical analysis and fundamental analysis. Most of the
research tools discussed in the earlier chapters are commonly associated with technical analysis. Given the
wealth of LIM data available, several types of fundamental analysis can also be generated.

There is a wealth of data series available to an agriculture futures trader (such as weather data or sentiment
data) that can be used to develop interesting research. For example, heavy buying or selling of the futures
contract could be the direct result of unforeseen changes in weather patterns.
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Problem
You will analyze the effect of a third- or fourth-quarter downpour of rain in Chicago on the price of the front
Soybean futures contract.

In the XMIM language, you want to SHOW the 1 week move of the front Soybean futures contract WHEN
the date is any third- or fourth-quarter where the rain precipitation is more than .35 repeated for the previous
2 days and current day. After the query is completed, the following text displays within the Edit pane of the
Query Builder window:

   SHOW 
     1: move from today to 1 week later  of Close of S  
   WHEN 
       RainPrecip of CHICAGO.OHARE.IL is more than 0.35 
       repeated for the previous 2 and current day 
     AND 
     {
         Date is third quarter 
       OR 
         Date is fourth quarter 
     } 
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Step-by-Step Solution

Select the Study of the Attribute
1. You want to take a look at the 1-week move of the close of the front Soybean contract.

When using studies, XMIM conveniently substitutes shorter frequencies of time for
periods missing within the database. For example, if the query asks for a 4-day average
and only 3 days are available for the study, XMIM will return a 3-day average. The term
value represents actually values in the database and is sometimes substituted for ‘day’ or
other frequencies to ensure that the studies calculate the specified number of values and
don’t substitute a shorter frequency for periods missing within the database. For example,
on a non-trading holiday XMIM will return a result for a study that requires n day average
because of the substitution feature in the software; however, the use of n value average will
return NaN.

2. In the SHOW pane of the Query Builder window type S into the Symbol field (or find the symbol using

the Search Database  button). Next, select Close from the Column pull-down menu.

3. Select the Studies  button and select move from the list. The Study: move window opens. Select
the Time Period button then select the radio button for the FROM/TO selection. In the From pull-
down select Today. In the To pull-down, select Time Offset. In the Time Offset window, select 1 if not
already highlighted. From the next pull-down change Day to Week and from the next pull-down, change
Ago to Later. Select OK to close the Time Offset window and OK to close the Time Period window.
Select OK to close the Study: move window then select the Add Attribute to Query  button to add
the statement to the Edit pane of the Query Builder window.

The following shows the query statement so far:

   SHOW 
     1: move from today to 1 week later  of Close of S 

Creating a Market Condition Using Weather Data
1. The custom event condition used in this lesson is a condition that makes a comparison of an attribute (the

rain precipitation in Chicago). In the WHEN pane of the Query Builder window, select the Custom
Event button. In the Custom Event window, in the Left Attribute pane of the window, you need to
look up our weather site, the O'Hare airport in Chicago, Illinois. Select the Search Database  button
and in the Tree View open the folders for Weather > Geophysical > Geo_N.Amer > Geo_USA.East



66
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 10: Event-Driven Analysis using Weather Data

> Geo_Illinois. Make the final symbol selection of CHICAGO.OHARE.IL then right-click and choose
Select. Select OK to close the Search Database window and return to the Custom Event window.
From the Column pull-down menu, select RainPrecip then select the Continue button to enter the
conditional operator.

2. From the Conditional Operator pane of the Custom Event window select the radio button for is
exactly then change exactly to more than from the pull-down menu. Select the Continue button to go
to the Right Attribute pane.

3. In the Right Attribute pane select the Variable  button and choose Constant from the list. Type .35
in the Constant field. The following shows the completed Custom Event window.
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4. Use the repeat function to repeat the weather condition for the previous 2 days and current day. In the
WHEN pane of the Query Builder window, select the Repeat  button. The Repeat window should
have two columns. You will ignore the left-most column and focus on making changes to the Repeat
Period column on the right. You want the weather condition to be repeated for the previous 2 days and
current day so you will have to uncheck Next. You need to change the number from 1 to 2 in the text
field next to Previous. If the Repeat Period pane of the Repeat window has Previous 2, Current and
Day highlighted select OK.The following shows the Repeat window entries:

Select OK to add the repeat statement to the Edit pane of the Query Builder window. The following
shows how the query should look so far:

  SHOW 
     1: move from today to 1 week later  of Close of S  
   WHEN 
       RainPrecip of CHICAGO.OHARE.IL is more than 0.35 
       repeated for the previous 2 and current day 

5. Next, select the AND logical operator from the list in the WHEN pane of the Query Builder window
and proceed to add the two date conditions.

6. In the WHEN pane of the Query Builder window, select the Date Time Condition button then select
the Date or Time button. Next, select Date is from the list. Select the within button and choose in
quarter >third quarter from the pull-down menu. The Date Time Condition window should have
Date is third quarter entered.

7. To add the final date condition select the Add Condition  button. Next, select the OR logical operator,
then select the Date or Time button. Choose Date is from the list, then select the within button and
choose in quarter> fourth quarter from the pull-down menu. If the Date Time Condition window has
Date is Fourth Quarter listed, select OK to add the statement to the Edit pane and return to the Query
Builder window.

8. The two date conditions (Date is third quarter or Date is fourth quarter) are obviously mutually
exclusive. Use braces to denote that one or the other of these conditions must be met along with the first
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two aforementioned conditions in order to SHOW our attribute. In the Edit pane add the curly braces to
the query so that the query matches the following:

   SHOW 
     1: move from today to 1 week later  of Close of S  
   WHEN 
       RainPrecip of CHICAGO.OHARE.IL is more than 0.35 
       repeated for the previous 2 and current day 
     AND 
     {
         Date is third quarter 
       OR 
         Date is fourth quarter 
     } 

9. Execute the query by selecting the Report  button from the toolbar.

      Date   Day          1
 
10/06/1959   Tue     1.8800 
09/13/1961   Wed    -6.5000 
09/14/1961   Thu    -2.0000 
09/25/1961   Mon    -2.8700 
09/14/1970   Mon    -8.5000 
09/15/1970   Tue    -2.5000 
09/24/1970   Thu    -4.7500 
08/20/1990   Mon     7.2500 
08/21/1990   Tue     7.7500 
10/09/1990   Tue   -24.0000 
10/10/1990   Wed   -10.5000 
11/03/1992   Tue    -5.5000 
08/05/1998   Wed     4.0000 
08/25/1998   Tue   -14.0000 
09/20/2001   Thu   -11.7500 
10/24/2001   Wed     4.0000 
11/04/2003   Tue    20.0000 
12/01/2006   Fri   -21.0000 
 
             Avg    -3.8328 
          AvgPos     7.4800 
          AvgNeg    -9.4892 
          PctPos    33.3333 
          PctNeg    66.6667 
         Maximum    20.0000 
         Minimum   -24.0000 
          StdDev    10.6574 
           ZStat    -0.3596 
        Variance   113.5793 

18 Occurrences

10. Notice that there are several consecutive days listed on the left-most column of the XMIM report. If you
were to actually take a position based on these conditions, it might be safe to say that you would react
to the first day that meets the conditions or the first adjacent value. XMIM allows you the ability to look
at the first adjacent days by changing the default Execute Options settings. Select Options>Execute
Options from the menu bar (or select the Execute Options  button from the toolbar) then select the
Report tab. Under the Report Manipulation pane change Display: All Adjacent Values to Display:
First Adjacent Value and select OK.
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11. Select the Report  button from the toolbar to re-execute the query. Notice that the number of
occurrences dramatically decline because of the changed default settings.

      Date   Day          1
 
10/06/1959   Tue     1.8800 
09/13/1961   Wed    -6.5000 
09/25/1961   Mon    -2.8700 
09/14/1970   Mon    -8.5000 
09/24/1970   Thu    -4.7500 
08/20/1990   Mon     7.2500 
10/09/1990   Tue   -24.0000 
11/03/1992   Tue    -5.5000 
08/05/1998   Wed     4.0000 
08/25/1998   Tue   -14.0000 
09/20/2001   Thu   -11.7500 
10/24/2001   Wed     4.0000 
11/04/2003   Tue    20.0000 
12/01/2006   Fri   -21.0000 
 
             Avg    -4.4100 
          AvgPos     7.4260 
          AvgNeg   -10.9856 
          PctPos    35.7143 
          PctNeg    64.2857 
         Maximum    20.0000 
         Minimum   -24.0000 
          StdDev    11.5773 
           ZStat    -0.3809 
        Variance   134.0335 

14 Occurrences

12. Dismiss the report and select the New button to clear the Edit pane for the next lesson.
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Language Lesson
An important calculation subtlety of XMIM is that a specified time period may include holidays or missing
data thereby effectively reducing the actual number of data points used in a study. For example, a 15-day
moving average that spans both Christmas and New Year's Day will be calculated based on only 13 price
samples. Many users prefer to calculate studies based on the last “n values” (this is the last actual n data points
irrespective of holidays or missing data) instead of the last “n time" (i.e., day) periods. You can accomplish this
in the XMIM language: specify, instead of “days” as the time period, the keyword “values” and the study will
be calculated using the specified number of values from the data series. This concept is particularly important
where the study is a triggering condition for the ORDER query (back testing trading ideas using an ORDER
query will be discussed in Chapter 14, “Back-Testing a Long-Only Moving Average Trading Strategy”).
If a date is a holiday, such as New Years Day, XMIM will return data on a non-trading day because of the
calculation subtlety discussed. Because it is impossible to ‘place’ a trade on a holiday this trading signal will be
ignored.
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Problem Solvers
For any date in December, January or February following 1990 where the low temperature at the New York
LaGuardia Airport, is down over 20% for two days in a row, show the move from this date (today) to 3 days
later of the front Natural Gas contract (NG).
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CHAPTER 11

Event-Driven Analysis on Multiple
Symbols

Synopsis

Objectives
1. Using a LET statement with multiple symbols.
2. Using the How Do I Say feature.

Market Brief
Often a query that provides useful insight regarding the historical patterns of one symbol can be applied to
multiple symbols. In previous lessons the problems focused the analysis on one symbol and how that one
symbol reacted to certain conditions, but with the XMIM LET statement it is possible to run that same query
on a list of symbols all at once.
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Problem
You will take a look at what's happened in the past to the NASDAQ, S&P 500 and NYSE indices, when the
index is up 9 days in a row. You will study the percent move from the event date to 1, 2, and 3 days later.
Using the LET feature, you will set a variable to equal our list of indices so that when you run the query,
you will get separate results for each index. You will also use the How Do I Say feature to provide syntax
assistance with our event condition that the index is up 9 days in a row. After the query is completed, the
following text will appear within the Edit pane of the Query Builder window:

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList  
     3: percent_move from today to 3 days later  of @MyList  
   WHEN 
       @MyList is up 
       repeated for the previous 8 and current value
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Step-by-Step Solution
1. Select the LET  button from the toolbar to open the LET window. In the Series Variable pane keep

the entry @MyList for the variable name and type NASD into the next field for the symbol name. Select
the Enter  button to add the symbol name NASD to the Specified Series pane.

The variable names shown are just suggestions. Variable names are user-defined but
should be in mixed case or start with an @ sign so that there is not a possibility of
duplicating a MIM symbol name. Also, no spaces are allowed.

2. Next, type the symbol name SPX into the symbol field and select the Enter  button to add SPX to the
Specified Series pane.

You may use the Remove Item  button to remove a symbol name from the Specified
Series pane, if needed.
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3. Next, type the symbol name NYSE into the symbol field and select the Enter  button to add NYSE to
the Specified Series pane. Select the OK button to close the LET window. The following displays in the
Edit pane:

   LET 
     @MyList = NASD, SPX, NYSE

4. In the SHOW pane select the  button and change the selection from Symbol to Variable. In the
Variable field type in the name @MyList. Select the Studies  button and choose % move from the list.

5. In the Study: % move window, select the Time Period button and select the radial next to From Today
To 1 Days Later. Select the OK button to close the Time Period window then select the OK button to
close the Study: % move window.

Notice that the Studies  button is highlighted to show that an entry was made.

6. In the SHOW pane select the Add Attribute to Query  button. The following shows the entries so far
in the Edit pane.

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList

7. Next, In the SHOW pane select the  button and change the selection from Symbol to Variable. In
the Variable field type in the name @MyList. Select the Studies  button and choose % move from the
list.

8. In the Study: % move window, select the Time Period button and select the radial next to From Today
To 1 Days Later. Select the To button and choose Time Offset from the list. In the Time Offset
window change 1 Day Later to 2 Day Later. Select the OK button in each window to return to the
Query Builder window.

Notice that the Studies  button is highlighted to show that an entry was made.

9. In the SHOW pane select the Add Attribute to Query  button. The following shows the entries so far
in the Edit pane.

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList 
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10. Next, In the SHOW pane select the  button and change the selection from Symbol to Variable. In
the Variable field type in the name @MyList. Select the Studies  button and choose % move from the
list.

11. In the Study: % move window, select the Time Period button and select the radial next to From Today
To 1 Days Later. Select the To button and choose Time Offset from the list. In the Time Offset
window change 1 Day Later to 3 Day Later. Select the OK button in each window to return to the
Query Builder window.

Notice that the Studies  button is highlighted to show that an entry was made.

12. In the SHOW pane select the Add Attribute to Query  button. The following shows the entries so far
in the Edit pane.

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList  
     3: percent_move from today to 3 days later  of @MyList

13. Select the How Do I Say  button from the toolbar. In the How Do I Say pane select IBM is Up
5 times in a row. Select the Customize button and in the Customize pane change 5 to 9 so that the
statement is IBM is up 9 times in a row. Select the Add to My Query button. The following shows the
query in the Edit pane:

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList  
     3: percent_move from today to 3 days later  of @MyList  
   WHEN 
       IBM is up 
       repeated for the previous 4 and current value

14. In the WHEN condition replace IBM with @MyList by editing the query in the Edit pane. The
following shows the finished query:

   LET 
     @MyList = NASD, SPX, NYSE

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList  
     3: percent_move from today to 3 days later  of @MyList  
   WHEN 
       @MyList is up 
       repeated for the previous 4 and current value
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15. Select the Report   button from the toolbar to generate the answers. Notice how the report shows
three separate results for each of the futures. The following shows a partial listing for each symbol in the
report:

Let variable values:
@MyList=NASD

      Date   Day           1           2           3
 
04/07/1971   Wed      0.2961      0.2961      0.7496 
04/08/1971   Thu      0.0000      0.4521      0.4337 
03/06/1972   Mon     -0.0391      0.4066      0.7585 
12/08/1972   Fri     -0.2368     -0.6511     -1.1025 
09/25/1973   Tue      0.7468      1.3388      1.2750 
09/26/1973   Wed      0.5876      0.5243      0.3164 
09/27/1973   Thu     -0.0629     -0.2696      0.4404 

Let variable values:
@MyList=SPX

      Date   Day           1           2           3
 
05/04/1928   Fri      0.8399      0.1482      0.0000 
05/07/1928   Mon     -0.6859     -0.8329     -0.9799 
07/02/1929   Tue      0.4277      0.4277      0.9266 
07/03/1929   Wed      0.0000      0.4968      0.6742 
08/01/1932   Mon     -3.9280      4.5826      6.7103 
08/02/1954   Mon     -0.1936     -0.2904     -0.7099 
09/17/1954   Fri     -0.4415      0.2523      0.9145 

Let variable values:
@MyList=NYSE

      Date   Day           1           2           3
 
04/06/1971   Tue      0.4285      0.5713      0.5713 
04/07/1971   Wed      0.1422      0.1422      0.8533 
04/08/1971   Thu      0.0000      0.7101      0.7811 
03/06/1972   Mon      0.1322      0.2974      0.3139 
03/07/1972   Tue      0.1650      0.1815     -0.3630 
03/08/1972   Wed      0.0165     -0.5271     -1.4660 
03/09/1972   Thu     -0.5435     -1.4822     -1.2022

16. Dismiss the report and select the New  button to clear the Edit pane for the next lesson.
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Problem Solvers
Create a query that looks at what happens in terms of percent move 1, 2, and 3 days later to the 2 year, 10
year and 30 year US Treasury Bond Futures when the wholesale inflation is higher than expected.
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CHAPTER 12

Analysis using Intraday Data

Synopsis

Objectives
1. Introducing execution units.
2. Introducing IF-THEN-ELSE statements.
3. Using studies on intraday data.

Market Brief
In the previous lessons you looked at the change of price in our security over some period of time. It might
be interesting to look at the prices during the day to research when specific events occurred. The intraday
data is provided in pricing bars. Price bars are a representation of the price at the open of a period, the close
of that period and the high and low reached during the period. XMIM allows us to look at price bars for any
period of time down to millisecond bars where intraday data exists for a series.
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Problem
For this lesson you will construct a query that uses the intraday data to indicate the exact minute the high
occurred for the continuous S&P 500 Future contract for the most recent trading date. In the previous
lessons, the conditions were checked on a daily basis throughout the history of the database (i.e., does 1/1/90
meet our condition? Does 1/2/90 meet our condition? Does 1/3/90? What about 1/4/90? etc.) and the
attribute displayed for each day meeting the specified conditions (i.e., display the daily Closing Price for
1/1/90, and display the daily Closing Price for 1/2/90, etc.). The common time period to check the WHEN
conditions and display the SHOW attribute was daily. In the XMIM language, the Execution Units (or global
time units) were set for the previous lesson to the default or 1 day setting.

In this exercise a query is being used to look closer at the data and research more about the intraday data on a
particular date. You will modify the Execution Units to 1 minute in order to access the intraday values. Also
an IF-THEN-ELSE statement will be used in the SHOW to mark where the high for the day occurred. After
the query is completed, the following text will appear within the Edit pane of the Query Builder window:

   SHOW 
     MinuteHigh: High of SP 
     Highest: highest from 08:30 am to 03:15 pm of High of SP  
     Indicator: IF 
                    High of SP is exactly highest from 08:30 am to 03:15 pm of 
                    High of SP  
                THEN 1 
                ENDIF  
   WHEN 
       Date is within 1 day
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Step-by-Step Solution
1. To begin, set the execution units to 1 minute. From the toolbar, select the Execution Units  button.

Change 1 Day to 1 Minute. Select OK to close the Execution Units window.

2. The next step towards making the query is to create the SHOW statement High of SP. In the Symbol
field type in SP (for the S&P 500 Future contract). For the Column, choose High from the pull-down
menu. Select OK to add the SHOW statement to the Edit pane of the Query Builder window. Change
the label in the Edit pane from 1: to MinuteHigh:.

3. To create the next line in the SHOW statement enter SP in the Symbol field and for the Column, choose
High from the pull-down menu. Select the Studies button from the SHOW statement pane then select
highest from the list. The Study: highest window opens. Select the Time Period button then select
the From button and from the pull-down menu select Condition>Date Time Condition. In the Date
Time Condition window select the Date or Time button then select Time is from the pull-down menu.
Keep exactly and enter the time 8:30 and select am. If the statement shows Time is exactly 8:30 am
select OK to close the window and return to the Time Period window for the study.

4. Next, select the To button and from the pull-down menu select Date Time Condition. In the Date
Time Condition window select the Date or Time button then select Time is from the pull-down menu.
Keep exactly and enter the time 3:15 and select pm. If the statement shows Time is exactly 3:15 pm
select OK to close the Date Time window and return to the Time Period window for the study. Select
OK to close the Time Period window.

5. Select OK to close the Study: highest window and return to the Query Builder. Select the Add
Attribute to Query  button to add the query statement to the Edit pane.

6. In the Edit pane of the Query Builder window, change the label 1: to Highest:. The following shows
the query progress:

   SHOW 
     MinuteHigh: High of SP 
     Highest: highest from 08:30 am to 03:15 pm of High of SP  

7. This step will show how to make an IF-THEN statement. In the SHOW pane of the Query Builder
window enter SP in the Symbol field and choose High for the Column.

In the SHOW pane, select the IF-THEN-ELSE  button. In the IF portion of the IF-THEN-
ELSE window select the Condition button and choose Custom Event from the pull-down menu. In
the Custom Event window enter SP in the Symbol field and choose High from the Column pull-down
menu. Select the Continue button.

In the Conditional Operator pane select the radial button for is exactly then select the Continue
button.

In the Right Attribute pane type SP in the Symbol field and choose High from the Column pull-down
menu. Select the Studies button and choose highest from the list. In the Studies:highest window select
the Time Period button and select the radial button next to From To.
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Select the From button and choose Condition>Date Time Condition. Select the Date or Time button
and choose Time is from the list. Keep exactly and change the time setting to 8:30 am then select the
OK button.

Next, select the To button and choose Condition>Date Time Condition. Select the Date or Time
button and choose Time is from the list. Keep exactly and change the time setting to 3:15 pm then
select the OK button. Close the Time Period window by selecting OK. Close the Studies:highest
window by selecting OK. Notice that the Studies  button is now highlighted. Select OK to close the
Custom Event window.

Next, in the THEN portion of the IF-THEN-ELSE window select the THEN Attribute button.
Select the Variable  button and choose Constant from the list. Type 1 in the Constant field and select
OK. Select OK to close the IF-THEN-ELSE window. Notice that the IF-THEN-ELSE  button is
now highlighted to show that it has entries. Select the Add Attribute to Query  button to add the IF-
THEN-ELSE statement to the query in the Edit pane.

8. The last step is to set the WHEN date condition for the query. From the WHEN pane select the Date
Time Condition button then select the Date or Time button and choose Date is from the list. Change
exactly to within and make sure 1 Day is selected. If the Date Time Condition window shows Date is
within 1 Day select the OK button to close the window and add the date condition to the query in the
Edit pane. The final query is as follows:

   SHOW 
     MinuteHigh: High of SP 
     Highest: highest from 08:30 am to 03:15 pm of High of SP  
     Indicator: IF 
                    High of SP is exactly highest from 08:30 am to 03:15 pm of 
                    High of SP  
                THEN 1 
                ENDIF  
   WHEN 
       Date is within 1 day

9. Select the Report   button to generate the answers for the query. Notice below that the 1.000 in the
Indicator column shows when the exact time the high of the day was made. (The following is a portion
of the report results.)

      Date      Time   Day   MinuteHigh    Highest   Indicator
02/05/2007   01:57pm   Mon   1454.0000   1454.0000     1.0000 

10. Dismiss the report and select the New  button to clear the Edit pane for the next lesson.
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Language Lesson
This lesson examined the intraday minutely data. XMIM has a setting called execution units which determines
the time-frequency over which queries will range through the database looking for answers. As mentioned,
the default frequency is daily but may be changed to any frequency from one minute to any number of
years. The execution units are set using the Options>Execution Units menu bar selection. Depending on
availability of data (most securities in the database have daily prices but not all of these securities have intraday
prices available), it is possible to create different time frequencies for the Symbol (that is, daily, weekly or
monthly pricing bars). If intraday data exists for a series, it is possible to display frequencies of minutes, hours,
days, week, months, quarters and years. Where no intraday data is available for a series, only frequencies
greater than intraday may be used for the query (that is, daily, monthly, quarterly or yearly). The default time
mechanism in XMIM is set to daily; however, a user may save their desired Execution Unit as the user default.

We also introduced how the IF-THEN-ELSE statement can be used to indicate when the High was made
during the day. The general formula for an IF-THEN-ELSE statement is IF condition is true THEN x ELSE
y. For the XMIM specifically, this can be translated to IF condition THEN Attribute A ELSE Attribute B. This
query did not specify an ELSE statement as it is not necessary for every IF-THEN-ELSE statement. We used
the THEN 1 as a visual indicator of the high of the day and if we had included ELSE 0 in our statement the 1
would not be as easy to spot. By leaving off the ELSE statement, a NaN is returned if the condition is not true,
making a 1 easier to see.

IF-THEN-ELSE statements can also be used to chain two histories together. For instance, if one time series
stops and another one starts, these can be linked together with the following syntax:

IF Column of SYMBOLA is defined THEN Column of SYMBOLA ELSE Column of SYMBOLB

Another use of IF-THEN-ELSE statements is to show a value when a condition has occurred. For instance
if you want to show the settlement price of a futures contract on its expiration day, the following syntax could
be used.

   IF Date is SP expiration_day THEN Close of SP
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Problem Solvers
Construct a query that uses the intraday data to indicate the exact minute the low occurred for the continuous
S&P 500 Future contract for the most recent trading date.
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CHAPTER 13

Event-Driven Analysis using Intraday Data

Synopsis

Objectives
1. Reiterating time offset.
2. Introducing attribute units.
3. Using a time condition.

Market Brief
When a stock or other trading instrument has a higher open price than the price that it closed at on the
previous day this is referred to as a gap. This can be a considerable move up or down in price with no trades
occurring between the official close and open of the market. Market events such as important meeting dates,
economic report releases, or earnings announcements, can cause these gaps to occur.
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Problem
In this lesson we are going to analyze what happens to the S&P 500 Index in the first hour of trading when a
gap has occurred and the open is more than the previous day’s close by more than $1. While on the same day,
an FOMC meeting occurred. You will use a percent move study to see how the index performed from 8:30
am, at the open to 9:30 am, the end of the first trading hour. Other percent move studies will also show how
the index performed the remainder of the day, from 9:30 am to 3:15 pm, and for the entire day as a whole
from 8:30 am to 3:15 pm. After the query is completed, the following text will appear within the Edit pane of
the Query Builder window:

   SHOW 
     FirstHr: percent_move from 08:30 am to 09:30 am of Close of SPX  
     RestofDay: percent_move from 09:30 am to 03:15 pm of Close of SPX  
     DailyMv: percent_move from 08:30 am to 03:15 pm of Close of SPX  
   WHEN 
       Time is 09:30 am 
     AND 
       Date is in "USA_FOMC_Rate_Meeting" 
     AND 
       The daily open of SPX - The daily Close of SPX 1 day ago  is more than 1
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Step-by-Step Solution
1. From the toolbar, select the Execution Units  button and choose Minutes from the pull-down menu.

2. Type the symbol name SPX into the Symbol field or select the Search Database  button and open the
folders in the Tree View to locate the symbol (open the folders for: Indices>U.S.Indices). Keep the
default Close as the column.

3. Select the Studies  button and choose % move from the list. In the Study: % move window select
the Time Period button. In the Time Period window select the radial button next to From and select
the From button. Choose Condition>Date and Time Condition from the pull-down menu. Select the
Date or Time button then choose Time is from the list. Keep the exactly button default and change
the time to 8:30 am. Select OK to close the Date Time window. Next, select the To button and choose
Condition>Date and Time Condition from the pull-down menu. Select the Date or Time button then
choose Time is from the list. Keep the exactly button default and change the time to 9:30 am. Select
OK to close the Date Time window. Select OK to close the Studies:% move window. Select the Add
Attribute to Query  button in the Query Builder to add the query statement to the Edit pane.

4. In the Edit pane change the label 1: to FirstHr:.

5. Repeat the steps above with the appropriate times to complete the next two next query statements so that
your query matches the following:

   SHOW 
     FirstHr: percent_move from 08:30 am to 09:30 am of Close of SPX  
     RestofDay: percent_move from 09:30 am to 03:15 pm of Close of SPX  
     DailyMv: percent_move from 08:30 am to 03:15 pm of Close of SPX

6. Now, setup the time condition Time is 09:30 am. From the WHEN pane, select the Date Time
Condition button then select the Date or Time button. Choose Time is from the list. Keep the exactly
setting then enter 9:30 am.

7. To enter another date condition, select the Add Condition  button.

The Refresh Condition  button will refresh the Date Time window so that a new
date or time condition can be constructed.

8. Next, select the Date or Time button then choose Date is from the list. Select the within button and
choose in file>server file. Select the Browse button and open the folders for Monetary>United
States>FOMC and choose USA_FOMC_Rate_Meeting from the list. Select OK to close the window.
Select OK to close the Date Time Condition window.

The following shows the query:

   SHOW 
     FirstHr: percent_move from 08:30 am to 09:30 am of Close of SPX  
     RestofDay: percent_move from 09:30 am to 03:15 pm of Close of SPX  
     DailyMv: percent_move from 08:30 am to 03:15 pm of Close of SPX  
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   WHEN 
       Time is 09:30 am 
     AND 
       Date is in "USA_FOMC_Rate_Meeting" 

9. From the WHEN pane, select the Custom Event button. For the Left Attribute, type SPX in the
Symbol field and choose Open from the Column field. Select the Attribute Units  button from the
SHOW pane and choose Day from the pull-down menu.

10. Select the Arithmetic Operator button and choose the radial button for Subtract. Type SPX in the
Symbol field and choose Close from the Column field. Select the Attribute Units  button from the
SHOW pane and choose Day from the pull-down menu. Select the Time Offset  button and keep the
1 Day Ago default. Select OK and notice that the Time Offset button is now highlighted to show that a
selection was made. Select the Continue button.

11. In the Conditional Operator pane, select the radial button next to is exactly and change exactly to
more than then select the Continue button. In the Right Attribute pane select the Variable button and
choose Constant from the pull-down menu. Type 1 in the Constant field. Select OK to close the window
and add the query statement to the Edit pane. The following shows the completed query:

   SHOW 
     FirstHr: percent_move from 08:30 am to 09:30 am of Close of SPX  
     RestofDay: percent_move from 09:30 am to 03:15 pm of Close of SPX  
     DailyMv: percent_move from 08:30 am to 03:15 pm of Close of SPX  
   WHEN 
       Time is 09:30 am 
     AND 
       Date is in "USA_FOMC_Rate_Meeting" 
     AND 
       The daily open of SPX - The daily Close of SPX 1 day ago  is more than 1

12. Dismiss the report and select the New  button to clear the Edit pane for the next lesson.
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Language Lesson
In this lesson, you used attribute units to force XMIM to observe data in a different unit than what the
execution units were set to. You used attribute units to compare the daily open of SPX to the daily close of
SPX. Generally, attribute units are used as the default time frequency for any attribute expressions built in
XMIM. Time frequency can also be set for each defined attribute (local settings) using the Attribute Units

 button located in the SHOW pane of the Query Builder window. The difference between the Attribute
Units located under Options>Attribute Units in the menu bar and the Attribute Units located in the
SHOW pane, is the version selected in the SHOW pane is specific to that one attribute and will override
the Option>Attribute Units menu version. Attribute Units accessible from Options>Attribute Units in
the menu bar will change the frequency of all attributes used either in SHOW attributes or within WHEN
conditions custom events. This query used a time offset to compare a price on our event date to a price on
the day before. You used time offset to compare the daily open of SPX on the event date to the daily close
of SPX on the day before the event date. The Time Offset menu selection is used to pick a date, relative to
‘today’ or the current date or time executed within the system. The simplest time offset takes the form of n
time-units [ago | later], such as "10 days ago" or "55 weeks later". Time offset is commonly used to anchor a
time period against the current execution date or time in XMIM.
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Problem Solvers
Create a query that studies the move in the first hour of the day for the 30 year US Treasury Bond Future
when The Bureau of Labor Statistics releases the Producer Price Index (PPI) within the last 10 years.

The PPI report comes out at 8:30 am EST but the time stamp on the data for US is CST since
the exchange it’s traded on is in Chicago.
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CHAPTER 14

Back-Testing a Long-Only Moving Average
Trading Strategy

Synopsis

Objectives
1. Introducing ORDER blocks.
2. Reiterating time offset.
3. Introducing ORDER options.

Market Brief
Prior to taking a position using an untried trading strategy most traders usually paper trade the strategy in
order to identify whether or not the strategy is appropriate. The trader documents the entry price, monitors
the trade, documents the price where the position closed out (that is, level where the stop loss, take profit
or position close would trigger) and evaluates the strategy following several iterations of this process. The
evaluation would take into account the overall profitability of the strategy, the maximum amount of draw
down, average length of time the position kept the trader in the market, etc. Obviously the longer period
of time the trader is able to paper trade the position the more information he or she would have about the
strategy. XMIM has the ability to enhance the paper trade process by allowing researchers to evaluate
systematic trading strategies over a long period of time.

At the beginning of this manual we explained that there are two major types of questions or queries that may
be posed in the software. Up to this point you have spent a substantial amount of time using the SHOW/
WHEN query. The SHOW/WHEN query provides quite a bit of utility and will be used for most of your
research ideas. The other type of query, the ORDER query, is a very powerful research tool and will build
onto your research ideas created by using the SHOW/WHEN query by back-testing your research strategies.
The ORDER query allows you the ability to buy or sell your security when certain conditions exist and to exit
out of your position when certain other conditions are present.
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Problem
You are going to build a very simple long-only moving average system. This system will place a buy order for
10 front S&P futures contracts anytime the closing price of the contract crosses above the 1-month average
of closing prices for that contract and will exit out of the position anytime the closing price crosses below the
1-month average. Because you are using a continuous futures contract series (which does not really exist) you
will need to roll your contracts. This means if you have a signal to buy 10 contracts and have not hit your exit
condition you will sell out of the contract at expiration and buy the new front contract. The following shows
how the completed query will look:

   1: ORDER 
     1.1: Buy 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses above 1 month average of Close of SP  
   EXIT 
       Close of SP crosses below 1 month average of Close of SP  
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Step-by-Step Solution

Working Within an ORDER Block
1. You will need to work within an ORDER block instead of a SHOW/WHEN. In the Query Builder

window, select Tools>Add Query Block>ORDER from the menu bar.

2. Notice that the Query Builder window now includes an ORDER pane and EXIT pane in addition to
the WHEN condition that you have used before.

Creating the Buy ORDER
1. In the ORDER pane, in the Trade pane, select Buy from the pull-down menu.

2. Enter 10 in the text field next to Contracts and type the symbol SP into the next text field. Before you
exit the window, you need to offset the date on which you will purchase your contracts. You might expect
XMIM to execute this query’s buy orders on the day after the condition is met because in the real world it
is impossible to simultaneously calculate the closing price of a security and place an order for that security
right at the close. Obviously, the simultaneous calculation and order placement would be impossible in the
real world but would occur using XMIM. In order to place the order on the next day, you must use the
time offset function. Select the Time Offset button.
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3. Change the time offset settings to 1 Day Later and select the OK button.

4. Next, you want to make sure that the order will be entered on the open of the day following the
condition. In the Enter/Exit pane, select Open from the Enter on the pull-down list.
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5. If your Buy Trade pane has 10 Contracts, SP, 1 Day Later and Enter on the Open highlighted, select
the Enter button to accept these selections.

Setting the Entry Condition
1. The WHEN pane is used to establish the entry condition for an ORDER. You will buy 10 contracts

anytime the closing price of contract crosses above the one-month average of the closing prices for the
contract. This condition is created using a custom event condition. This custom event condition will
require the completion of a left attribute (Close of SP), a conditional operator (crosses above) and a right
attribute (one month average of Close of SP). In the WHEN pane select Condition and then choose
Custom Event from the pull-down menu.

2. In the Custom Event window in the Left Attribute pane type in SP in the Symbol field and choose
Close from the Column pull-down menu. If the Left Attribute pane has SP and Close highlighted,
select the Continue button.

3. Within the Conditional Operator pane select crosses above and then select the Continue button.

4. In the Right Attribute pane, type SP in the Symbol field and choose Close as your Column. Select the
Studies  button and choose average from the list. In the Study: average window select the Time
Period button. In the Time Period window, change 1 Day to 1 Month and select OK to close the Time
Period window. The Studies  button is highlighted to show that a selection was completed. Select OK
to complete and close the Custom Event window.

Setting the Exit Condition
1. Our exit condition is going to be the same as our entry or WHEN condition except that, instead of

selecting crosses above, you will choose crosses below for your conditional operator. In the Exit pane
select the Condition button then choose Custom Event from the pull-down menu.

2. In the Left Attribute pane, type SP in the Symbol field and choose Close for the Column then select the
Continue button.

3. In the Conditional Operator pane, select the radio button for crosses below then select the Continue
button.

4. In the Right Attribute pane, type SP in the Symbol field and choose Close for the Column. Select the
Studies  button and choose average from the list. In the Study: average window select the Time
Period button and change 1 Day to 1 Month and select OK to close the Time Period window. The
Studies  button is highlighted to show that a selection was completed. Select OK to complete and close
the Custom Event window.
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Setting the Rollover Policy
1. The query should now resemble the example illustrated in the problem above. You cannot execute your

query, however, because you haven't dealt with making sure that our futures contract will roll upon
expiration. In the real world you would have to sell out of the front contract upon expiration and buy the
back contract in order to stay in the trade. You can simulate this by changing the Entry & Exit ORDER
options. From the toolbar, select the Execute Options  button then select the ORDER tab. In the
Entry & Exit pane for Rollover select Re-entry Number of Contracts from the pull-down menu.  

2. Another ORDER option that is helpful to use is Print Reason for Trade located in the Report Details
pane of the Execute Options (ORDER tab) window. Select the check box to activate the Print Reason
for Trade option then select OK to close the window.

3. From the toolbar, select the Report button to execute the ORDER query. Notice that the statistical
information on your trading activity appears at the top of the report with all of the transactions appearing
on the lower portion of the report.
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4. There are several other key functions that can be used in your ORDER query. These functions include
setting your stop loss and take profits for the trade. These concepts and others are more appropriate for
intermediate training courses. For more information, see the  XMIM Profit/Loss User Manual.

http://www.lim.com/pdfdocs/profit_loss6x.pdf
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Language Lesson
In this lesson you pulled together several of the analytical functions you worked on in earlier lessons. In
addition to the technical studies used in the query, the lesson introduced the basic Buy Trade window and
the rollover options.

There are several very useful options available to enhance your ORDER query accessible from the Execute
Options menu (to access the menu, select the Execute Options  button from the toolbar). For example,
there are options that will allow for slippage and commission for each trade.
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Problem Solvers
Create a profit-loss study, that begins after 1995, to purchase 2000 shares of Dell Computer stock anytime the
closing price crosses above the 1-week average of the closing price and exit upon a reverse signal.
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CHAPTER 15

Back-Testing Long and Short Moving
Average Trading Strategies

Synopsis

Objectives
1. Introduction to multiple ORDER blocks.
2. Reiteration of the ORDER window.

Market Brief
A popular strategy used with momentum based trading systems is to close out an open position and initiate a
reverse order upon a reverse signal. Typically, the reverse signal is the exit condition of the original trade.

XMIM has the ability to create multiple query blocks. You may create a compound query block by simply
adding a new query block to your existing query.
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Problem
You are going to build onto the query created in the preceding lesson by adding an additional query block
to trigger a short position or a sell trade whenever the exit conditions of your buy trade are activated. This
system will place a buy order for 10 front S&P futures contracts anytime the closing price of your contract
crosses above the 1 month average of closing prices for that contract and will exit out of the position anytime
the closing price crosses below the 1 month average. Additionally, the system will place a sell order for 10
front S&P futures contracts anytime the closing price of the contract crosses below the 1 month average of
closing prices for that contract and will exit out of the position anytime the closing price crosses above the 1-
month average. The following shows how the query will look when completed:

   1: ORDER 
     1.1: Buy 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses above 1 month average of Close of SP  
   EXIT 
       Close of SP crosses below 1 month average of Close of SP  

   2: ORDER 
     2.1: Sell 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses below 1 month average of Close of SP  
   EXIT 
       Close of SP crosses above 1 month average of Close of SP  
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Step-by-Step Solution

Adding an Additional ORDER Query
1. In the Query Builder window, from the menu bar, select Tools>Add Query Block>ORDER. Notice

that a second ORDER block appears within the Edit pane.

   1: ORDER 
     1.1: Buy 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses above 1 month average of Close of SP  
   EXIT 
       Close of SP crosses below 1 month average of Close of SP  

   2: ORDER

2. In the Trade pane, select Sell from the pull-down menu.

3. Next, enter 10 next to the Contracts field and type the symbol SP into the Symbol text field. Before
you exit the window, offset the date when the contracts will be sold. Select the Time Offset button
and change the settings to 1 Day Later and select OK. Next, select Open from the Enter on the pull-
down located in the Entry/Exit pane to ensure that the trade will be activated on the morning after the
conditions are met. If the Trade pane has Sell, 10 Contracts, SP, 1 Day Later and Enter on the Open
listed, select the Enter button to accept these selections.

The following shows your query progress:

   1: ORDER 
     1.1: Buy 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses above 1 month average of Close of SP  
   EXIT 
       Close of SP crosses below 1 month average of Close of SP  

   2: ORDER 
     2.1: Sell 1 day later  10 contracts of SP 
       Enter on the open

Setting Entry Conditions
1. In the previous lesson, it was mentioned that the WHEN pane for an ORDER block is used to establish

the entry condition for our ORDER. In this lesson, you will sell 10 contracts anytime the closing price for
the front S&P futures contract crosses below the 1-month average of the closing prices for the contract.
From the WHEN pane select the Condition button then select Custom Event from the pull-down
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menu. In the Left Attribute pane, type SP in the Symbol field and choose Close from the Column field.
Select the Studies  button and choose average from the list. In the Study: average window change
1 Day to 1 Month and select the OK button to close the window. Notice that the Studies  button is
highlighted to show that an entry was made. Select the Continue button to proceed to the Conditional
Operator pane.

2. Within the Conditional Operator pane select the radio button for crosses above and select crosses
below from the pull-down menu. Select the Continue button to proceed to the Right Attribute pane.

3. In the Right Attribute pane, type SP in the Symbol field and choose Close as the Column. Select the
OK button to enter the selections into the Edit pane and return to the Query Builder window.

Setting Exit Conditions
1. The exit condition is going to be the same as our entry condition except that, instead of selecting

crosses below, you will choose crosses above for your conditional operator. In the Exit pane select the
Condition button and choose Custom Event from the pull-down menu.

2. In the Left Attribute pane, type SP in the Symbol field and choose Close for the Column then select the
Continue button.

3. In the Conditional Operator pane, select the radio button for crosses above and select the Continue
button.

4. In the Right Attribute pane, type SP in the Symbol field and choose Close for the Column. Select the
Studies  button and choose average from the list. In the Studies: average window, select 1 month
and select the OK button to close the window. Notice that the Studies  button is highlighted to show
that you have made an entry. Select the OK button to add the entries to the Edit pane and return to the
Query Builder window.

5. The rollover options have not been reset, so go ahead and execute the query by selecting the Report
button from the toolbar. The execution time for the query will dramatically increase because of the
addition of the new query block.
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Language Lesson
This lesson focused on creating compound query blocks. Another interesting query block to add on to this
lesson would be a SHOW/WHEN query so that you could graph the cumulative equity curve of this trading
system. From the menu bar, select Tools>Add Query Block>SHOW WHEN. From the SHOW pane
select the Profit Loss  button to add final statistics to the query.

From the Profit Loss Statistics window, select Final Statistics from the Profit-Loss Statistics pull-down
menu then check the box for Equity. Select the OK button to close the window. Notice that the Profit Loss

 button is highlighted to show that an entry was made. Select the OK button to add the entry to the query
in the Edit pane.

After the query is completed with the SHOW/WHEN statement, the query will match the following:

   1: ORDER 
     1.1: Buy 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses above 1 month average of Close of SP  
   EXIT 
       Close of SP crosses below 1 month average of Close of SP  
   2: ORDER 
     2.1: Sell 1 day later  10 contracts of SP 
       Enter on the open 
   WHEN 
       Close of SP crosses below 1 month average of Close of SP  
   EXIT 
       Close of SP crosses above 1 month average of Close of SP  

   SHOW 
     1: equity  

As you probably guessed it is possible to add an infinite number of query blocks to the research study. A
common XMIM research technique is to create an advanced allocation process whereby new ORDER blocks
representing unique trading strategies will be added to create a smoothed equity curve.
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Problem Solvers
Create the same profit loss study as above but substitute the Gold futures contract.
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CHAPTER 16

Using "My Queries" to Store Frequently
Used Queries

Synopsis

Objectives
1. Create a My Queries button.
2. Learn about the Templates button.

Market Brief
Many queries are useful to run on a daily or frequent basis. The Best Match Analog is a query that is quite
useful in comparing the recent trading pattern of a symbol and finding a historical period in time that is highly
correlated to what is occurring now. When XMIM is installed, this particular query is provided under the My
Queries pane for your convenience. Once a query button is created under the My Queries pane the user
can select the button for the query and the graph or report for the query will generate depending on which
one you designated to generate. There is no need to locate and open the query file and then run the graph or
report on the query. This area makes retrieving and running the results on your favorite queries quite simple.
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Problem
In this lesson, you will save the following query under the My Queries pane. This query shows the Close of
the Dow Jones Industrial Average index and the 65 day average over the last 3 months.

   SHOW 
     DJIA: Close of DJIA 
     65DyAvg: 65 value average of Close of DJIA  
   WHEN 
       Date is within 3 months
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Step-by-Step Solution
1. In the SHOW pane of the Query Builder window type DJIA into the Symbol field and choose Close

from the Column pull-down menu. Select the Add Attribute to Query  button to add the query
statement Close of DJIA to the Edit pane. Edit the query in the Edit pane and change the label 1: to
DJIA:. The following shows the query progress:

   SHOW 
     DJIA: Close of DJIA

2. Next, type DJIA into the Symbol field and choose Close from the Column pull-down menu. Select the
Studies  button and choose average from the list.

3. In the Study: average window select the Time Period button. Change the selection from 200 Days
to 65 Values. Select the OK button to close the Study: average window. Select the Add Attribute to
Query  button to add the query statement 65 value average of Close of DJIA to the Edit pane. Edit
the query in the Edit pane and change the label 1: to 65DyAvg:.T he following shows the query progress:

   SHOW 
     DJIA: Close of DJIA 
     65DyAvg: 65 value average of Close of DJIA 

4. For the WHEN condition select the Date Time Condition button then select the Date or Time
button and select Date is. Change the time to 3 and the Day to Month so that the statement is Date is
within 3 Month. Select the OK button to close the Date Time Condition window and add the WHEN
condition to the query in the Edit pane. The following shows the query progress:

   SHOW 
     DJIA: Close of DJIA 
     65DyAvg: 65 value average of Close of DJIA  
   WHEN 
       Date is within 3 months

5. Next, select Tools>My Queries>Add Current Query from the menu bar. The Add Current Query
window opens. In the Query Name pane type DJIA Daily for the query name. Ensure that the radial
button for Graph is selected in the Action Event pane. Select the Save button and note that there is a
new button entry under My Queries called DJIA Daily.

When selecting this button in the future the graph will run automatically.
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Language Lesson
The Best Match analog query that was mentioned in the "Market Brief" section can be edited two ways. You
can right-click on the button in the My Queries pane and select View Query to make manual edits in the
query window. However, this is a complex query and manual editing requires a good understanding of the
query. The preferred alternative is to use the Templates  button on the toolbar. The Templates feature
provides an easy way to customize the Best Match analog and the Threshold analog. You can also run the
customized analogs from this location eliminating the need to open the analog in the query window at all.
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Problem Solvers
Save the query below in the My Queries pane as "SPX Daily".

   SHOW 
     SPX: Close of SPX 
     65DyAvg: 65 value average of Close of SPX  
   WHEN 
       Date is within 3 months

When completed, select the SPX Daily button to run this query as a graph.



116
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 16: Using "My Queries" to Store Frequently Used Queries



XMIM FINANCIAL TRAINING GUIDE
Chapter 17: Bringing Data into Excel from XMIM

117
 

CHAPTER 17

Bringing Data into Excel from XMIM

Synopsis

Objectives
1. Bringing your results into an Excel spreadsheet.
2. Setting options for copying/pasting into Excel.

Market Brief
It is easy to share analysis between XMIM and popularly used programs such as Microsoft Excel®. Just select
the Paste to Excel button located at the bottom of your Report window to copy your query results into an
Excel spreadsheet for further analysis. In addition, there are option settings in the User  Preferences menu
that control how the results are brought into Excel. This lesson steps you through the process of bringing
results into Excel and shows how to change the Excel option settings.
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Problem
In this lesson, you are going to copy the results of a query into Microsoft Excel. Specifically, an XMIM report
containing the last month of closing prices for the front continuous S&P futures contract will be copied and
then pasted into an Excel spreadsheet. Before you get started working the steps for the solution, take a look
at the section below on the "Excel Option Settings".
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Excel Option Settings
There are three Excel option settings in the User Preferences menu. To access the User Preferences menu,
select Options>User Preferences from the menu bar.

Excel Pane
For these options, Excel must be running with a workbook open to receive the data from the application. The
following describes the three Excel options:

Option Function
Copy Table Results to Clipboard This option allows the user to put the Report results in another application.

This option is checked (activated) by default.

Send Paste Command to Excel This option will paste the results of a Report into an open Excel worksheet.

With only the Send Paste Command to Excel selected
it is possible to overwrite content on the opened Excel
worksheet. To prevent this, check the Send New
Worksheet and Paste Command to Excel option.

Send New Worksheet and Paste Command to Excel Creates a new worksheet in Excel and pastes the results of a Report into
the new worksheet.



120
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 17: Bringing Data into Excel from XMIM

Step-by-Step Solution
1. Create a SHOW/WHEN query that will SHOW the closing price for the continuous S&P futures

contract (Close of SP) WHEN the date is within the last month. After you have completed the query, the
following text will appear within the Edit pane of the Query Builder window:

   SHOW 
     1: Close of SP 
   WHEN 
       Date is within 1 month 

2. Execute an XMIM report by selecting the Report  button from the toolbar.

3. To copy and paste the report in Excel open the Excel program and select Ctrl+V from the keyboard or
Edit>Paste to paste the selection.

In XMIM, if the Copy Table Results to Clipboard option is unchecked the report
results can still be pasted into an Excel spreadsheet by selecting the Paste to Excel
button located at the bottom of the Report window.
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Problem Solvers
Populate an Excel spreadsheet with the last 2 months of closing prices for the closing level of the Dow Jones
Industrial Average Index.
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CHAPTER 18

Problem Solver Answers

The following lists the answers to the problem solver questions for each chapter.

Problem Solver, Chapter 3: Event Driven Analysis using
the Query Wizard Market Events

Question
Create a query using the Query Wizard that shows what happens to the 30-year US Treasury Bond future
contract 1 week and 2 weeks later when the close price is up extra big and the day before it made a new 52-
week low.

Answer
   SHOW 
     t+1: percent_move from today to 1 week later  of US  
     t+2: percent_move from today to 2 weeks later  of US  
   WHEN 
     1 day ago 
       low of US is less than 52 week lowest of low of US  1 value ago  
     AND 
       1 value percent_move of US  is more than 
       (30 day average of 1 value percent_move of US   + 
        (3 * 30 day std_dev of 1 value percent_move of US  
        )
       ) 
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Problem Solver, Chapter 4: Event Driven Analysis using
the Query Wizard Date Events

Question
Create a query using the Query Wizard that shows what happens to the NASDAQ index each day over the
next 3 days when the FOMC has a meeting.

Answer
   SHOW 
     t+1: percent_move from today to 1 day later  of NASD  
     t+2: percent_move from today to 2 days later  of NASD  
     t+3: percent_move from today to 3 days later  of NASD  
   WHEN 
       Date is in "USA_FOMC_Rate_Meeting"
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Problem Solver, Chapter 5: Basic Pricing Graphs

Questions
1. Construct a query that will graph the closing yield for the U.S. 10-year Treasury Bond.

2. Construct a query that will graph the opening price for the U.S. 30-year Treasury Bond futures contract.

Answers
1.    SHOW 

     1: Close of USC10 

2.    SHOW 
     1: Open of front US 
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Problem Solver, Chapter 6: Limiting the Graph to a
Relevant Period of Time

Questions
1. Construct a query to graph the bar and range of Dell Computer Corporation stock for the last 2 years.

2. Construct a query to graph the bar of the front S&P futures contract as well as the daily range for the last
52 weeks.

Look for your symbol in the Search Database, Tree View menu, under Futures >
MktIndices > USA_Equities.

Answers
1.    SHOW 

     1: BAR of DELL 
     2: range of DELL  
   WHEN 
       Date is within 2 years 

2.    SHOW 
     1: BAR of front SP 
     2: range of front SP  
   WHEN 
       Date is within 52 weeks 
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Problem Solver, Chapter 7: Using a Technical Indicator
with a Price Graph

Questions
Create a 2-week correlation study of the close of the Dow Jones Industrial Average Index (DJIA) and
NASDAQ Composite Share Index (NASD) for the last 6 months.

In the Search Database, Tree View menu, look under Indices > U.S.Indices for both
symbols.

Answers
   SHOW 
     1: 2 week correlation of Close of DJIA and Close of NASD  
   WHEN 
       Date is within 6 months 
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Problem Solver, Chapter 8: Basic Event Driven Analysis
using Date Conditions

Questions
1. Create a study that analyzes the 1-day percent move of the 30-year U.S. Treasury Bond futures contract

following all a Nonfarm economic release falling after 1993.

2. Create a study that analyzes the 1-week move of the front S&P futures contract leading up to all U.S.
holidays.

Answers
1.    SHOW 

     1: percent_move from today to 1 day later  of front US  
   WHEN 
       Date is in "nonfarm.rpt" 
     AND 
       Date is after 1993 

2.    SHOW 
     1: move from 1 week ago  to today of front SP  
   WHEN 
       Date is any holiday 
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Problem Solver, Chapter 9: Basic Event Driven Analysis
using Market Conditions

Questions
1. Create a study that analyzes the 1-day move of the Euro dollar, following all Producer Price Index release

dates falling after 1995 whenever the actual Producer Price Index release is less than the consensus
estimate.

2. Create a study that analyzes the 1-week move of the 30-year U.S. Treasury Bond following all Home Sales
release dates within the last 3 years whenever the actual Home Sales release is less than the consensus
estimate.

Answers
1.    SHOW 

     1: move from today to 1 day later  of Close of EURUSD  
   WHEN 
       Date is in "ppi.rpt" 
     AND 
       Date is after 1995 
     AND 
       PPI_ACT is less than PPI_EST 

2.    SHOW 
     1: move from today to 1 week later  of front US  
   WHEN 
       Date is in "homesale.rpt" 
     AND 
       HOMESALE_ACT is less than HOMESALE_EST 
     AND 
       Date is within 3 years 
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Problem Solver, Chapter 10: Event-Driven Analysis using
Weather Data

Question
For any date in December, January or February following 1990 where the low temperature at the New York
LaGuardia Airport, is down over 20% for two days in a row, show the move from this date (today) to 3 days
later of the front Natural Gas contract (NG).

Answer
 SHOW 
     1: move from today to 3 days later  of front NG  
   WHEN 
       Date is after 1990 
     AND 
       LowTemp of NEW.YORK.LA.GUARDIA.NY is down more than 20 % 
       repeated for the previous and current day 
     AND 
     {
         Date is December 
       OR 
         Date is January 
       OR 
         Date is February 
     } 
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Problem Solver, Chapter 11: Event-Driven Analysis on
Multiple Symbols

Question
Create a query that looks at what happens in terms of percent move 1, 2, and 3 days later to the 2 year, 10
year and 30 year US Treasury Bond Futures when the wholesale inflation is higher than expected.

Answer
   LET 
     @MyList = TY, TU, US

   SHOW 
     1: percent_move from today to 1 day later  of @MyList  
     2: percent_move from today to 2 days later  of @MyList  
     3: percent_move from today to 3 days later  of @MyList  
   WHEN 
       Date is in "ppi.rpt" 
     AND 
       (PPI_ACT - PPI_EST) is more than 0 
     AND 
       Date is within 2 years



132
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 18: Problem Solver Answers

Problem Solver, Chapter 12: Analysis using Intraday Data

Question
Construct a query that uses the intraday data to indicate the exact minute the low occurred for the continuous
S&P 500 Future contract for the most recent trading date.

Answer
   SHOW 
     MinuteLow: Low of SP 
     Highest: lowest from 08:30 am to 03:15 pm of low of SP  
     Indicator: IF 
            Low of SP is exactly lowest from 08:30 am to 03:15 pm of Close 
            of SP  
        THEN 1 
        ENDIF  
   WHEN 
       Date is within 1 day
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Problem Solver, Chapter 13: Event-Driven Analysis using
Intraday Data

Question
Create a query that studies the move in the first hour of the day for the 30-year US Treasury Bond Future
when The Bureau of Labor Statistics releases the Producer Price Index (PPI) within the last 10 years.

The PPI report comes out at 8:30 am EST but the time stamp on the data for US is CST since
the exchange it’s traded on is in Chicago.

Answer
%exec.units: 1 minute 
   SHOW 
     FirstHr: percent_move from 07:30 am to 08:30 am of Close of US  
   WHEN 
       Time is 08:30 am 
     AND 
       Date is in "USA_BLS_Producer_Price_Index" 
     AND 
       Date is within 10 years
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Problem Solver, Chapter 14: Back-Testing Your Long-
Only Moving Average Trading Strategy

Question
Create a Profit-Loss study, that begins after 1995, to purchase 2000 shares of Dell Computer stock anytime
the closing price crosses above the 1-week average of the closing price and exit upon a reverse signal.

Answer
   1: ORDER 
     1.1: Buy 1 day later  2000 shares of DELL 
       Enter on the open 
   WHEN 
       Date is after 1995 
     AND 
       Close of DELL crosses above 1 week average of Close of DELL  
   EXIT 
       Close of DELL crosses below 1 week average of Close of DELL
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Problem Solver, Chapter 15: Back-Testing Long & Short
Moving Average Trading Strategies
This problem solver question is self-explanatory.
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Problem Solver, Chapter 16: Using "My Queries" to Store
Frequently Used Queries

Question
Save the query below in the My Queries pane as "SPX Daily".

   SHOW 
     SPX: Close of SPX 
     65DyAvg: 65 value average of Close of SPX  
   WHEN 
       Date is within 3 months

When completed, select the SPX Daily button to run this query as a graph.

Answer
The SPX Daily button will be in the My Queries pane and when clicked on, the resulting graph displays.
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Problem Solver, Chapter 17: Bringing Data into Excel
from XMIM
This problem solver question is self-explanatory.



138
 

XMIM FINANCIAL TRAINING GUIDE
Chapter 18: Problem Solver Answers



XMIM FINANCIAL TRAINING GUIDE
Chapter 19: Glossary

139
 

CHAPTER 19

Glossary

Arithmetic Operator – Attributes or data series can be combined using simple arithmetic operations like
addition, subtraction, division, etc., through the use of an arithmetic operator.

Attribute - Attribute is a complete description of a time series - an array of numbers, organized in
chronological order, usually with a regular frequency.

Attribute Units - Attribute unit is the default time-frequency for any attribute expression built in XMIM.

Condition – Condition provides the ability to restrict the results of a query or question about the markets to
specific dates and times of interest.

Condition Connector – The condition connectors, such as AND, OR, XOR, AND NOT, are used to create
compound conditions within a query (i.e. 1st Condition AND 2nd Condition).

Custom Event - Conditions that incorporate Attributes are built using the Custom Events button accessible
from the WHEN pane of the Query Builder. The custom event general format is: <Left Attribute>
<Conditional Operator> <Right Attribute>

Date Time Condition – The Date Time Condition provides the ability to restrict the results of a query or
question about the markets to specific dates or times.

Date Event - Refine a query using date events accessible from the Query Wizard. For a description of each
date event, see the "Date Events" appendix in the XMIM User Guide.

Edit Pane – The query displays within this pane after building a query using the Query Builder or the Query
Wizard.

Execution Units - Execution units determine the time-frequency over which queries will range through the
database looking for answers. The default frequency is daily but may be changed to any frequency from 1
minute to any number of years.

How Do I Say - Use the list of examples in the How Do I Say window as a starting point for building and
customizing your own queries. Queries may be saved and added to this window for reuse. To access the list of
examples, select the How Do I Say  button from the toolbar.

Label – The column title in the XMIM report or graph is created manually by editing the labels in the Edit
pane. For example, in the query statement 1: Close of NG the text 1: is the label and may be changed to any
name, such as Henry Hub:.

LET - To invoke the LET function, select Tools>LET from the menu bar. The LET statement allows the
user to assign properties to variables and is defined in the query above the query block. This variable may

http://www.lim.com/pdfdocs/xmimuser6x.pdf#Date_Event_Descriptions
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be used to range the query over different symbols or values, used in place of complex query statements, or
query data from a file. The variable may be used as a short-hand substitute that can be used again and again
throughout the query.

Market Event - Refine a query using market events. For a description of each market event, see the "Market
Events" appendix in the XMIM User Guide.

ORDER -Much of the power of the P/L module derives from the notion of an order block. An order
block consists of a set of trade orders (buy, sell, and/or exit) and conditions. The trade orders are ‘placed’
when the conditions are satisfied. To create an order block, from the menu bar select Tools>Add Query
Block>ORDER.

Query - English-like questions created to poll the database. Queries are composed of SHOW/WHEN and
ORDER blocks.

Query Builder – Guides the user through the process of building a correct query using the XMIM language.

Query Wizard - Use this feature to build complex queries using pre-defined market and date events.

Relation – A data structure represented in XMIM by a the unique identifiers consisting of a symbol and
column.

Search Database – Select the Search Database  button to locate symbols and columns in the database.
In the Short-Cut menu, create short-cuts to often used symbols. You can use the Tree View menu to locate
specific symbols and add them to your query. The Search menu allows searches by symbol or by description
and can be set to narrow the search to specific categories in the MIM database.

SHOW/WHEN – To invoke the SHOW/WHEN function (default), select Tools>Add Query
Block>SHOW WHEN from the menu bar. The SHOW/WHEN query allows a user to query what
happens to the market when certain conditions are present. Or stated another way, the SHOW/WHEN query
is constructed as a compound sentence which, in general terms states "XMIM, show me what happens to my
specified data series whenever a defined condition (or conditions) are true." This type of query requires the
user to specify both the market of interest and the condition or time period for which the user would like to
see the market displayed. The 'market of interest' is created by defining what it is the user wants to "SHOW".
This may be accomplished by either making certain menu selections using the SHOW pane of the Query
Builder or by typing in the SHOW criteria directly into the Edit pane. Likewise, the condition or time period
for which the user expects to see the market displayed is created by using the WHEN pane of the Query
Builder or by typing in the WHEN criteria directly into the Edit pane.

Templates - LIM provides a list of pre-built queries (templates) that may be modified for your own use. For
example, the Templates menu shows how to create the complicated and often used analog query. To access
the list of templates, select the Templates  button from the toolbar. Select a template from the pull-down
list to build a query. Enter the parameters and select the Add to Query  button to paste the modified
query into the Edit pane of the Query Builder window. Select the Return to Query Builder  button if
you want to exit the Templates window.

Time Offset - The Time Offset menu is used to pick a date, relative to today or the current date executed
within the system.

http://www.lim.com/pdfdocs/xmimuser6x.pdf#market_events_description
http://www.lim.com/pdfdocs/xmimuser6x.pdf#market_events_description
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